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1 QUICK START
1.1

What is PEAXACT?

PEAXACT is a comprehensive software product for quantitative analysis of spectroscopic and
chromatographic data using several state-of-the-art and innovative analysis methods.
PEAXACT contains ready-to-go calibration-free methods as well as calibration methods for
the prediction of features from unknown samples. It offers quick-and-easy access to established methods like Peak Integration or Partial-Least-Squares and is the only software product that provides the innovative Indirect Hard Modeling method.
PEAXACT can be used for laboratory analytics as well as for process analytics and reaction
monitoring either interactively using the user interface or remotely in combination with thirdparty software.

Separation to Related Software Products
PEAXACT strongly focuses on quantitative data evaluation of spectra, i.e. determination of
the quantity of pure component and mixture properties from measured spectra. PEAXACT is
optimized for IR and Raman spectra, but can also be used for other kinds of peak-shaped data
like NMR spectra and chromatograms.
PEAXACT is not designed for the identification of chemical structures of measured compounds.
PEAXACT does not replace measurement software for spectrometers such as OPUS (Bruker
Optics), HoloGrams (Kaiser Optical Systems Inc.), iC-Software-Suite (Mettler Toledo), and
others. In fact, PEAXACT operates on data measured with such software products.
PEAXACT is equipped with several data analysis methods. Some of these methods may also
be distributed with other software tools. However, unique hard modeling methods like Indirect Hard Modeling (IHM) and Hard Modeling Factor Analysis (HMFA) are available in
PEAXACT only.

1.2

Getting Help

User Manual
This user manual documents a certain version of PEAXACT. You can find the version number
and publication date on the title page.
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We are continuously working on improving the manual. The latest document version is distributed as PDF file with each PEAXACT software update. The file is located in subdirectory
help of the PEAXACT installation directory.

Technical Support
The Technical Support can be contacted in different ways:
•
•
•

E-mail to support@s-pact.de
Web form at http://www.s-pact.com/support
From the PEAXACT desktop (see Request Support)
Note: A subscription of S•PACT Software Maintenance Service (SMS) is required
to be eligible for technical support. The first year of SMS is included with new
PEAXACT product licenses.

Blog
The PEAXACT Blog was launched as a free source of information complementary to the user
manual. It contains tutorials and tips & tricks.
See: http://www.s-pact.com/blog

1.3

Installation & License Activation

1.3.1
•
•
•
•
•

Requirements

Microsoft Windows 7 SP1 or later (32-bit or 64-bit)
Any Intel or AMD x86 processor with SSE2 support (2 GHz recommended)
1 GB of disk space (2 GB recommended)
2 GB RAM (4 GB recommended)
No specific graphics card is required. Hardware accelerated graphics card supporting
OpenGL 3.3 with 1GB GPU memory recommended.

1.3.2

Licensing

PEAXACT software is furnished under a license agreement. The software may be used only
under the terms of the license agreement.
License conditions vary with respect to license type, license option, and license modules. This
Section only gives a short overview of the different license options. For the full and legally
valid conditions please refer to the license agreement document.
Note: Depending on the modules of your particular license, you may not be able to
access all PEAXACT features.
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License Options
Individual
PEAXACT can be installed and operated by a single designated named user on up
to 2 designated computers.
Group
PEAXACT can be installed on a specified number of computers and can be operated by an unlimited group of users (one user per computer at a time).
Network
PEAXACT can be installed on any number of computers in a network and can be
operated by a specified number of users simultaneously. Licenses are shared
among all network users. This option requires the PEAXACT License Server.

1.3.3

Installation

Step 1: Before You Install
•
•
•
•

Make sure your computer fulfills the system requirements.
When upgrading an existing installation, visit
http://www.s-pact.com/peaxact/whatsnew and read the upgrade notes first.
Make sure you have administrator privileges to perform the installation.
Make sure your license is valid for the major version number. If you do not have a license yet you can get a free trial license or purchase a license after installation.
Note: The PEAXACT version consists of two numbers
<major version>.<minor version>, e.g. 4.6

Step 2: Install PEAXACT
•

Download the PEAXACT Installer from http://www.s-pact.com/peaxact/download
Note: The installer's filename is peaxactInstaller_<version>_<platform>.exe
<version> is the version number; <platform> is either win32 or win64. The 32-bit version also runs on 64-bit platforms, but not vice versa.
Note: Different major versions can be installed side-by-side, e.g. versions 3 and 4.
Note: The installer upgrades earlier installations of the same major version.

Online Installation (Web Installation)
•
•

If you are going to install PEAXACT on a computer which is connected to the internet,
you do not need to download any additional files.
Run the PEAXACT Installer and follow the setup instructions. Additional runtime
packages are downloaded and installed automatically if detected missing.
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Offline Installation
•
•
•
•

If you are planning to install PEAXACT on a computer without internet access, you
have to download additional runtime packages in advance from
http://www.s-pact.com/peaxact/runtime
Make sure to download runtime packages for the same platform as the PEAXACT installer (32-bit or 64-bit)
Save all installer files to a folder on your hard drive / flash drive. Do not rename files.
Run the PEAXACT Installer file from this folder and follow the setup instructions.
Runtime packages are installed automatically if detected missing.

Step 3: After Installation
•
•

After a new product installation continue with License Activation.
After upgrading an existing installation check the upgrade notes at
http://www.s-pact.com/peaxact/whatsnew for further upgrade steps.

1.3.4

License Activation

License activation involves loading a valid license file.

Step 1: Get your license file
•
•
•

If you already have a license file continue with step 2.
To get a trial license, visit http://www.s-pact.com/peaxact. Once you have received
your license file continue with step 2.
For purchased licenses, licenses activation associates the use of PEAXACT with designated computers by means of a Host ID. The Host ID is a MAC address or the serial
number of volume c of the computer PEAXACT is installed on.
• From the Windows start menu select Programs>PEAXACT 4>Activate PEAXACT
• Wait until the License Activation Dialog is displayed
• Copy the Host ID from the dialog window and send it to support@s-pact.de
• Click Cancel for now. Once you’ve received your license file continue with step 2.
Note: You can also type getmac at the command prompt and use the first MAC address as Host ID.

Step 2: Activate license
•
•

From the Windows start menu select Programs > PEAXACT 4 > Activate PEAXACT
Wait until the License Activation Dialog is displayed
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1

2

4

3

License Activation Dialog
(1) License selection
(2) Status of activation
•

(3) Additional license information
(4) Apply and close

Choose Import License… from the list (1) to browse for a valid license file. If the license is valid the license file is copied to the license directory. Alternatively, you can
select Free Viewer License from the list (1), but this license would limit functionalities
to reading and viewing model and data files only.
Note: Choose Check-out from License Server… if you want to use a shared network license. Please ask your license administrator for details.

•

Once a valid license is selected, you can click on the License Info button (3) to learn
more about the license or on the OK button (4) to accept the selection.
Per-machine license vs. per-user license
If you perform the activation with administrator privileges licenses will be activated
per-machine, i.e. for all Windows users. Otherwise, licenses will be activated peruser, i.e. for the logged-on user. Per-machine licenses take precedence over peruser licenses. Once a per-machine license is activated the License Activation Dialog gets locked for regular users.

1.4

Starting the PEAXACT Program

There are several ways to start the PEAXACT program on a Microsoft Windows platform:
•
•

Click the Windows start menu and select Programs > PEAXACT 4 > PEAXACT 4
Double-click the PEAXACT 4 icon on the Windows desktop
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Open a command window, cd to the PEAXACT installation folder and type peaxact at
the command prompt.

After starting PEAXACT, a welcome screen opens while the program is loading.
Note: Starting PEAXACT may need several seconds (up to a minute) for loading
the MATLAB Runtime.
If you start PEAXACT without a valid license you will be prompted to activate a license.
If your computer is connected to the internet, a check for updates is performed at startup.
You will be informed in case a new version is available.
If you have trouble starting PEAXACT, see Troubleshooting information.

Startup Options

Command Line Interface
PEAXACT can be started from the command line with additional parameters. Note that some
command line options depend on the license. Type PEAXACT –help to see all available options
for your license.
Parameters in square brackets are optional. Angle brackets represent placeholders which
must be replaced by specific values. The vertical bar (|) separates alternative arguments.
PEAXACT
PEAXACT -help | -manual
PEAXACT [-logLevel debug|exception|info|warning|severe|off]
[-logFile <file> | -noLogFile]
[-openglfix]
[-predict]
[-restore | -session <file>]
[<file1> [<file2> [...]]]
-help
display help for command line usage
-manual
open user manual
-logLevel
set verbosity of text output (default = info)
-logFile <file> set path and name of log file (default = APPDATA\peaxact.log)
-noLogFile
disable text output to log file
-openglfix
fix graphics problems with some video cards
-predict
run analysis (prediction) without GUI
requires calibrated model and data files to be loaded
-restore
reload most recently saved session
-session <file> load session file
<file*>
load additional files. These can be:
model files, data files, or data tables
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Additional notes:
•
•
•

Option -predict must be used in combination with -restore or -session <file> or
with <filen*> in order to load models and data sets for the analysis.
Starting predictions from the command line has advantages over the graphical user
interface. Learn more in Section Prediction.
Filenames must be quoted if they contain spaces, e.g. "c:\my data\file A.pxm"
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2 INPUT AND OUTPUT FILES
PEAXACT reads and writes several files for different purposes. This Section explains these file
types and their usage.
Note: This manual uses the placeholder APPDATADIR to refer to the user directory
for application data which typically is
%LocalAppData%\S-PACT\PEAXACT 4

However, the actual directory can be seen in the Preferences Editor or when typing
peaxact -help at the command line.

2.1

Model File

The central element of PEAXACT is the model file. Almost everything you do with PEAXACT
is related to models. You use PEAXACT to create and edit models, load and save models, and
apply models for data analysis.
The PEAXACT model is called master model. Each model file stores one master model with
all its sub-models and settings.
PEAXACT is backward compatible. It can read (but not write!) model files of previous versions. Please note that PEAXACT refuses reading model files saved with newer versions.
File Extensions
*.fpm
*.pxm

2.2

PEAXACT Model file prior to version 3 (read-only)
PEAXACT Model file since version 3

Data File

A data file contains one or more samples, each of which consists of x-data (wavenumbers,
frequencies …) and y-data (intensities). PEAXACT supports various file formats and reads
even 3D data (i.e. files containing multiple samples), and 4D data (i.e. files containing multiple
frames of multiple samples). Many data files may also contain complementary information.
However, this kind of data is ignored (but for a very few exceptions) because it is optional and
varies too much between different file formats.
Supported File Formats for Reading
*.0
OPUS files
*.cdf
Common Data Format files
*.csv
Text files (comma separated values)
*.dpt
Text files (blank separated values)
*.txt
Text files (delimiter separated values)
*.dx *.jdx *.jcm
JCAMP-DX files
*.mat
Matlab MAT files
*.sp
Perkin Elmer Spectrum files
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Thermo Nicolet OMNIC files
Galactic SPC file
WinSPEC files
LabVIEW TDMS files

*.spa *.spg *.srs
*.spc
*.spe
*.tdms

Text format
Text formats like CSV, DPT, and TXT must contain tabularly structured data. The first
table column is interpreted as x-data while following columns are interpreted as
y-data. Table headers will be ignored.
MATLAB format
Data in MATLAB MAT files are recognized when the file contains one numeric matrix variable. The variable's name can be arbitrary. The first matrix column is interpreted as x-data while following columns are interpreted as y-data.
LabVIEW format
LabVIEW TDMS files can contain any number of named groups, each of which can
contain any number of named channels, each of which contains data points. Data
are recognized when a group contains two channels with the same number of data
points. The first of those channels is interpreted as x-data, the second one as ydata. Group names and channel names can be arbitrary.
Supported File Formats for Writing
PEAXACT tries to avoid writing data files. However, there are a few operations
that save data to files. You can choose between the following formats:
*.mat
Matlab MAT files
*.csv
Text files (comma separated values)

2.3

Data Table File

A data table file is a spreadsheet file (e.g. a Microsoft Excel file) that contains data sets. Each
row of the table represents a data set. Each column represents a data set feature.

Data Table
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The concept of data tables is an easy way to manage data that belongs together. See also
Data Set Management for further information.
File Extension
*.xls
*.xlsx
*.csv

Excel 97-2003-workbook
Excel 2010-workbook
Text files with tabular data separated by a delimiter character

Data Set
A data set consists of at least a unique reference to a sample (see URI), and optional features.
URI
A uniform resource identifier (URI) unambiguously identifies a specific sample in a
data file. The URI is a name composed of the data file's name followed by the number sign (#) and an access ID (URI = <dataFileName>#<accessID>). A URI with missing access ID (and missing number sign) refers to all samples in the file.
Access ID
•
•
•

For most 2D data files (single sample) and 3D data files (multiple samples), the
access ID simply is the sample number within the file (e.g. #3).
For 4D data files (multiple frames), the access ID is the frame number followed
by the sample number within the frame (e.g. #10-3)
For OPUS files, the access ID is the block name followed by the sample number
within the block (e.g. #AB-3)

Features
Features are pieces of information that are related to samples. There are two kinds
of features: predictive features, e.g. concentrations, and non-predictive features,
e.g. timestamps. Non-predictive features are recognized by the following special
names: Usage, Timestamp, Time, Location. Other feature names automatically indicate predictive features.
Table Format
PEAXACT is able to read data table files as long as the following formatting rules
apply:
• First table column contains sample URIs (with absolute or relative paths)
• First table row contains feature names (except for first column)
• Rows without URI as well as columns without feature name are ignored
• URIs without access ID refer to all samples in a file
• Values of predictive features must be numeric
• Values of non-predictive features are treated in a special manner:
• Usage: values can be unspecified, train, test, or ignore
• Timestamp: date and/or time as text or serial number
• Time: any numeric value, used to tag a temporal sequence
• Location: any numeric value, used to tag a spatial sequence
• Empty cells are interpreted as missing values
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In case of duplicate URIs, feature values are merged (values from rows further
down take precedence over values from rows further up)
In case of duplicate feature names, only the first occurrence is considered
For Excel files, only the first worksheet is considered

Session File

A session file is a snapshot of the PEAXACT workspace at the exact moment the session is
saved. Loading a session file restores the workspace and allows you to continue working
where you stopped before.
PEAXACT can automatically save session files on shutdown (see preferences).
File Extension
*.mat
*.pxs

PEAXACT Session file up to version 2.x (read-only)
PEAXACT Session file since version 3

Auto-Save Directory
APPDATADIR\sessions

2.5

Session Profile File

A session profile contains all session-related preferences. Profiles can be added, removed, or
modified with the Preferences Editor.
PEAXACT is shipped with pre-defined profiles for typical applications.
File Extension
*.profile

PEAXACT session profile

Directory
APPDATADIR\profiles

Pre-defined profiles
Factory.profile
Chromatography.profile
Mid-IR.profile
NIR.profile
NMR.profile
Raman.profile
UV-Vis.profile

2.6

License File

The license file contains information about a license, e.g. the licensed release version. On
startup, PEAXACT searches the Windows registry for a license filename, reads the file or asks
for a valid license file if none could be found.
File Extension
*.lic

PEAXACT License file
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License Filenames in the Windows Registry
HKEY_LOCAL_MACHINE\S-PACT\PEAXACT 4\LicenseSource

takes precedence over:
HKEY_CURRENT_USER\S-PACT\PEAXACT 4\LicenseSource

License Directory
%ProgrammData%\S-PACT\PEAXACT 4

2.7

Report File

Report files are used to export graphical or tabular reports. Depending on the report, different file formats are available such as text, table, or image files.
Supported Formats
.pdf
.xls
.xlsx
.csv
.dpt
.txt
.jpg
.png
.tiff
.bmp
.eps
.mat
.fig

Portable Document Format
Microsoft Excel 97-2003 Workbook
Microsoft Excel Workbook
Comma separated values
Tab separated values
Blank separated values
JPEG Image File
PNG Image File
TIFF Image File
Bitmap Image File
Encapsulated Post Script Image File
Matlab MAT File
Matlab Figure File

Default Directory and Filename
Writing reports typically involves a File Dialog which you can use to browse directories and choose a filename. A default filename is suggested according to the
heuristic below. Default filenames are used automatically when PEAXACT is running in non-interactive mode.
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Default filename is composed of the active model's name (or “Untitled” if no
model is active), a suffix which identifies the report (e.g. prediction), and a
consecutive number to avoid overwriting existing files.
Default report directory is specified in model settings.
Is the specified directory an absolute path?
Yes! Default directory is
taken from model
settings as is

No (relative path)!
Has the model been saved to the hard disk before?
Yes! Default directory
is relative to the
model's path

2.8

No! Default
directory is
APPDATADIR\reports

Log File

By default, PEAXACT writes messages, warnings and errors to a log file. The verbosity of the
log file can be changed using the command line parameter –logLevel. File logging can be disabled completely using the command line parameter –noLogFile.
Directory and Filename
APPDATADIR\peaxact.log
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3 PEAXACT USER INTERFACE
PEAXACT is a graphical user interface for the quantitative analysis of spectroscopic data.
Functionality covers all aspects of data-driven and model-based analysis, namely data visualization and inspection, modeling of data with the goal of highlighting useful information,
and reporting of results. Using PEAXACT, you get easy access to multiple analysis methods
from a common platform.
Features include:
•
•
•
•

•
•

2D and 3D data visualization
Data pretreatments such as resampling, baseline correction, standardization
Interactive data modeling
Data analysis with several analysis methods, e.g.
• Peak picking
• Peak integration
• Principal component analysis (PCA)
• Rank analysis based on principal components
• Multivariate Curve Resolution (MCR-ALS)
• Hard Modeling Factor Analysis (HMFA)
• Peak fitting / Peak deconvolution
• Component fitting
• Indirect Hard Modeling (IHM)
• Partial Least Squares (PLS)
Customizable reporting
Exporting to several output formats, e.g. PDF, XLSX, CSV, JPG; PNG, EPS, FIG
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Desktop

When you start the PEAXACT program it displays the Desktop. The desktop is a set of control
panels for managing models, data sets, and features associated with PEAXACT.
1
2

6
4

7

5

3

PEAXACT Desktop with opened models and loaded data sets
(1)
(2)
(3)
(4)
(5)
(6)
(7)

Menu bar
Toolbar
Status bar
Model Tree Panel
Data Sets Panel
Properties Panel
Plot Panel

The desktop is structured into four panels. Drag the gray bar between two panels to resize
them or hide/re-show panels by clicking the arrows on the resize bar.
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Menu bar

The Menu bar gives access to all actions:
1

2

3

4

5

Desktop Menu bar
(1)
(2)
(3)
(4)
(5)

3.1.2

File:
Data:
Edit Model:
Analysis:
Help:

Model File Management, Preferences, Sessions
Data Set Management, Data Inspector
Modeling Tools
Analysis & Reporting
Documentation, Support, Licensing, Web Resources…

Toolbar

The Toolbar gives quick access to frequently used actions:
1

2

3

4

5

6

7

8

9

Desktop Toolbar
(1)
(2)
(3)
(4)

(5)
(6)
(7)
(8)
(9)

3.1.3

New Model, Open Model, Save Model
Load Data Files, Load Data Table Files
Open Data Inspector
Modelling Tools:
Add Integration Range, Add & Auto-fit Peaks, Import Components, Adjust Peaks,
Adjust Components, Calibration
Linear Component Fit, Component Fit according to model settings
Full zoom, Full y-zoom
Zoom in, Zoom out, Move center, Data cursor
Show Preferences Editor
Show User Manual

Status bar

The Status bar displays the current status and status updates.
1

2

3

Desktop Status bar
(1)

Busy Indicator: shows whether PEAXACT is currently busy and cannot respond to
mouse-clicks or pressed keys.
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(2) Current Profile: shows which session profile is currently active. Left-click to open the
Preferences Editor.
(3) Status Message: gives information on the last action carried out. It will also display
error information if the last action could not be carried out correctly. Left-click opens
the message console window, where all recent status messages are displayed.

3.1.4

Model Tree Panel

The Model Tree Panel (located top left of the desktop) lists all opened master models, each
one represented as tree structure. Use the tree to access certain model elements.
1
2
12

3
4
5

6
7
8

9

10
11

Model Tree Panel
(1) Empty item
(2)
Master Model item, contains the following information
•
•
•

Calibration type (if any): [HM], [PLS] or [PI]
Model name (default name is Untitled)
Asterisk symbol (*) when model has unsaved changes

(3)
(4)
(5)
(6)

Pretreatment Model item
Integration Model item
Integration Range item, contains range name
Hard Model item, optionally contains the name of the sample (in brackets) the
model was last fitted to
(7)
Baseline Model item
(8)
Component Model item, contains component name
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(9)
Peak Model item
(10)
Calibration Model item
(11)
Calibrated Feature item
(12) Selected/active element

Selecting and Activating Model Elements
Left-clicking an element of the tree selects it. The selected element becomes the active element. Only one element can be selected at a time.
Activating model elements affects other parts of the GUI:
•
•
•

Display of the element's parameters (see Properties Panel)
Display and/or highlighting of the element's plot (see Plot Panel)
Enabling of element-specific actions in the Menu bar and Toolbar

By selecting a Master Model item (2) or any of its subentries (3)-(11), the model becomes the
active model. Many operations of PEAXACT implicitly refer to the active model.
Sometimes it is favorable to not have any model active. Select the empty item (1) for this
purpose.

Context Menu
Right-clicking an item selects it and opens an element-specific context menu.

3.1.5

Data Sets Panel

The Data Sets Panel (located bottom left of the desktop) lists all data sets that are currently
loaded. Use the panel to access certain data sets.
1
2

3

4

Data Sets Panel
(1) Empty item
(2) Data Set item
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The name of each data set is composed of different kinds of information:
• Sample name and access ID
• [C] marks data sets for which a component fit is available
The name also informs about data set features:
• train, test, ignore: data set usage
• # feat.: number of available predictive features
• loc.: measurement location available
• t: measurement time or timestamp available
(3) Selected elements
(4) Active data set

Selecting Data Sets
Many features of PEAXACT – including all analysis methods – are applied to selected data
sets. Left-clicking and holding the mouse button selects one or more data sets. Doing this
while the CTRL-key is pressed allows you to select multiple ranges. Press CTRL+A in order to
select all items.

Activating a Data Set
The last selected data set becomes the active data set. Its name is displayed in bold characters. Some operations of PEAXACT implicitly refer to the active data set.
When activating a data set whose URI points to a file that doesn't exist, you will be prompted
to update the data set. See Update Missing Files.
Activating a data set affects other parts of the GUI:
•
•

Display of the sample's plot (see Plot Panel)
Enabling of specific actions in the Menu bar and Toolbar

Sometimes it is favorable to not have any data set active. Select the empty item (1) for this
purpose.

Context Menu
Right-clicking into the data sets panel opens the context menu.

3.1.6

Properties Panel

The Properties Panel (located top right of the desktop) can be used to display either Model
Properties or Data Set Properties. Switching between these property panels by clicking on
the corresponding heading displays further information in the panel. Each panel changes its
appearance according to the selected element in the Model Tree Panel or Data Sets Panel
respectively.

Solutions for Process Analytics & Control Technology

3 - PEAXACT USER INTERFACE

23

Model Properties
The panel displays parameters of the model element as selected in the Model Tree Panel.
Some parameters are displayed for information purposes only, others are editable. Use the
controls (e.g. edit fields, pull-down menus, tables) to change parameter values.
1

2

Model Properties Panel
(1) Name of currently selected model element
(2) Individual controls (depending on the selected model element) for displaying and
editing model parameters

Data Set Properties
When the Data Set Properties Panel is active, information about the active data set currently
selected in the Data Sets Panel is displayed. A table containing information on the data set
file, its XY data and all features is available.
1

2

Data Set Properties Panel
(1) Categories File and XY-Data display non-editable information
(2) Category Features is editable

3.1.7

Plot Panel

The Plot Panel (located bottom right of the desktop) changes its appearance according to
the items selected in the Model Tree Panel and in the Data Sets Panel. The Plot Panel is used
for graphical output. It also offers a way to interactively edit the model by using the mouse
for modifying plots.
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1

2

3

Plot Panel
(1) Name of active model and/or active data set
(2) Model and/or sample plot
(3) Residual plot
The residual plot is only visible if both, a master model and a data set are active, and in addition, if the master model contains a hard model.

Available Graphs
Sample
Graph of xy-data of the active data set's sample (black line).
If a model is active in the Model Tree Panel, the sample is modified according to the active model's pretreatment model.
The sample plot cannot be modified interactively.
(Hint: Use the Data Inspector to plot multiple samples)
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Excluded Ranges
Graph of excluded ranges of the active model's pretreatment model
(transparent gray patches).
Excluded range patches can be modified with the mouse (see preferences).

Integration Ranges
Graph of integration ranges of the active model's integration model (colored patches).
Integration range patches can be modified with the mouse.

Hard Model and Residuals
Graph of baseline model (dashed blue line), component models (solid
blue lines), and peak models (cyan lines) of the active model's hard
model (red line).
Baseline and peak plots can be modified with the mouse (when not in
component fit preview mode). The red line cannot be modified; it is the
sum of the other plots.
If a data set is active in the Data Sets Panel, the sample's xy-data is plotted, too, and the differences (residuals) between hard model (red line)
and sample (black line) are shown in a second graph.

Interactive Modeling
Most model-related lines and patches can be modified interactively with the mouse. Available actions differ from graph to graph but typically include:
•
•
•
•

left-clicking a graph in order to select the corresponding element in the Model Tree
Panel
dragging a graph while the left mouse-button is pressed in order to change the graphs'
position or shape
right-clicking a graph in order to open the corresponding context-menu
hitting the DEL-key in order to delete the corresponding element from the model

Detailed descriptions can be found in Section Modeling.
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Preferences

3.2.1

Preferences Editor

Menu bar:
Toolbar:
Status bar:

File > Preferences
Left-click on session profile name

The Preferences Editor can be used to adjust PEAXACT settings.
1
2

3

4

5

Preferences Editor
(1)
(2)
(3)
(4)
(5)

Select category
Preferences of selected category
Apply changes and close dialog
Discard changes and close dialog
Apply changes without closing the dialog

Changing Preferences
Choose a category from the list (1) and then change preferences using the controls in the right
pane (2). Click the OK (3) or Apply (5) button to accept changes; click the Cancel (4) button to
discard changes.
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7

6

9
8

Session Preferences (Session Profile)
(6)
(7)
(8)
(9)

Session preferences
Select session profile
Information about the profile
More options for resetting, saving, or deleting the profile

Changing the Session Profile
Session-related preferences are stored in profiles. There are several profiles for different purposes but only one profile can be active at a time.
After selecting the Session category (6) use the pull-down menu (7) to select a profile and
load its preferences into the editor. Click the OK or Apply button to accept the loaded session
preferences.
Change session preferences using the controls in the right pane. The info bar (8) tells you
when the current session profile has changes. If you want to reset or save those changes, click
button (9) to bring up the context menu with more options. If you select another profile while
the current one has changes, you will be asked whether you want to save changes first.
Note: You do not have to save profile changes. It is sufficient to click the OK button
to accept all changes.
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Reset, Save, Create, or Delete Session Profile
Click the Save button (9) in order to bring up the context men with more options for the current session profile:
• Reset to Last Saved State
Reload the profile from its file
• Reset to Factory Defaults
Available only for pre-defined profiles
• Save as “<name>”
Save changes under its current name
• Save as…
Save the profile under a new name
• Delete
Available only for user-created profiles
Note: Saving a profile does not automatically accept the new preferences. You still
have to click the OK button.

3.2.2

Application Settings

Application Data Directory
PEAXACT uses a special application data directory to save files at runtime. The directory cannot be changed, but for your convenience it is displayed in the Preferences Editor and can be
opened in the Windows explorer by clicking the button next to the field.

Main Window / Plot Panel
Ignore excluded ranges for auto-scaling of y-axis
Value
Description
Enabled

Y-axis limits are adjusted automatically to fit only
the relevant measured signal, i.e. any signal that is
not excluded.

Disabled

The y-axis is scaled automatically to fit the full
measured signal.

Allow mouse modification of excluded ranges
Excluded ranges are displayed as gray patches in the Plot Panel. These patches
typically overlap other plots such as integration range plots or peak plots.
This option specifies the behavior when clicking on an excluded range patch.
Value

Description

Enabled

Excluded range patches could be modified interactively using the mouse. In this case it may be difficult
to interactively modify other plots which are overlapped by patches.
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Excluded range patches cannot be modified interactively. Instead, it is easier to click and modify plots
which are overlapped by patches.

Show hard model baseline as separate plot
Value
Description
Enabled (rec- A separate plot for the baseline model is displayed
ommended) in the Plot Panel. The plot can be used to interactively modify the baseline.
Disabled

The baseline model is still calculated but it is not displayed as a plot. Instead, the baseline model is subtracted from the active sample and the corrected
sample is displayed in the Plot Panel. This needs to
get used to but has the advantage of the sample signal being shifted towards zero, which sometimes
may be favorable for modeling.

Miscellaneous
Number of model undo steps
The number specifies how many of the most recent modeling steps can be undone.
Auto-save session on exit
Auto-saving behavior of sessions during shutdown
Value

Description

Never

Current session is never saved automatically

Ask

The user is always asked before auto-saving the current session

Always

Current session is automatically saved on shutdown

Keep latest N
N specifies the number of auto-saved session files to keep on the hard disk.

3.2.3

Graphical Report Settings

Graphics Style
Font Style
Choose font family, font decoration, and font size for text in graphical reports
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Plot Style
Value

Description

Title

Show/Hide titles of graphical reports.

Axis Labels

Show/Hide descriptive labels at each axis.

Axis Ticks

Show/Hide axis tick labels.

Legend

Show/Hide legend (if any).

Export
Image export resolution (DPI)
This option only applies when exporting images to a file.
Value

Description

Auto

A default resolution for exporting graphical reports to
file. The actual value depends on the output file format.

72, 100,
150, 200,
300, 600

A fixed resolution (in dots per inch) for exporting
graphical reports. A larger value improves image quality, but also increases file size.
Note: The value is ignored when copying graphical reports to clipboard because the clipboard has a limited
size.

Image export to clipboard
This option only applies when copying images to clipboard using the Copy-tool
from the toolbar.
Value

Description

Rendered

Graphical reports are copied as raster images (bitmaps).

Vector

Graphical reports are copied as vector images.
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Table Report Settings

Table Style
General report information at the top
Value
Description
Enabled

Tabular reports start with a few rows containing general information like the report creation time or the
model file the analysis is based on (if any).

Disabled

The report consists of analysis results only.

Include data set features
Value
Description
Enabled

The report's result table is expanded to the right to also
include all available features of the data sets being analyzed.

Disabled

The report consists of analysis results only.

Timestamp first
Value

Description

Enabled

Timestamp values are treated in a special way and - if
available - are added as first column to the left of result
values and other feature values.

Disabled

Timestamp value are treated like other feature values.

Export
Delimiter character for CSV files
Character to be used as delimiter when saving comma separated value (CSV) files.
Hint: You probably want to stick with a comma but if you would like to open CSV
files in Microsoft Excel try switching the delimiter to semicolon if Excel does not
recognize the comma as a delimiter.

3.2.5

Session Settings

Sample
Sample X-Axis, Sample Y-Axis
Labels for the x and y values of a sample
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Reversed
Value

Description

Enabled

The sample x-axis is displayed reversed (right-toleft). This is characteristic for IR, Raman, and NMR.

Disabled

The sample x-axis is displayed normally (left-toright). This is characteristic for chromatograms.

Default OPUS file block
OPUS files may contain several different data blocks. Whenever PEAXACT opens
an OPUS file it only loads the default block. If an OPUS file to be loaded does not
contain the default block all blocks are loaded instead.

Results
Calculate areas of hard model components
Value
Description

3.2.6

Enabled

For hard models, the contribution of hard model
components to a mixture is typically expressed in
terms of component weights (relative component
areas). When this option is enabled, absolute component areas are calculated in addition to component weights and displayed next to weights in reports.

Disabled

No calculation of hard model component areas.

Pretreatment Model Settings

Note: All settings described in this Section are both, preferences and model-specific settings. In the Preferences Editor, settings are treated as defaults for new
models. After copied to a new model, settings can be modified for each model individually in the Model Properties Panel.
Some pretreatments modify x-data (wavenumber, frequency) while others alter y-data (intensities). Data Pretreatments are applied before any analysis in the following order:
•
•
•
•
•
•
•

Resampling
Global range
Unit conversion
Baseline correction
Smoothing / Derivatives
Standardization
Excluded ranges
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Modification of X-Values
Resampling
Value

Description

None

Disabled

Thinning

Data thinning reduces the number of data
points. A thinning factor of N keeps every N-th
data point. The thinning factor can be any
decimal number greater than or equal to 1.

Equidistant points

Resamples data at a specified number of new
x-values. A number of points of N recalculates
y-values at N equally spaced x-values within
the visible range by linear interpolation.

Reference x-axis

Resamples data at new x-values provided by
a specified reference file. Y-values are recalculated at the same x-values of the reference
sample by linear interpolation. Reference xvalues are permanently stored in the model.

Global range
The global range defines the smallest and largest x-value. Only signal in between
is considered for analysis. This is useful for cutting off noisy or unwanted signal at
the edges.
Excluded ranges
Excluded ranges are defined by a lower and upper x-value. Signal in between is not
considered for analysis. This is useful for cutting off local signal artifacts.

Modification of Y-Values
Unit Conversion
Converts the signal to another unit.
Value

Description

None

Disabled

Transmittance > Absorbance

Converts transmission to absorbance spectra.
𝐴𝑏 = −log(𝑇𝑟)

% Transmittance > Absorbance

Converts relative transmission
(given in percent) to absorbance
spectra.
𝐴𝑏 = −log(𝑇𝑟/100)
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Baseline correction
Baseline correction subtracts a background signal from measured data.
Value

Description

None

Disabled

Offset subtraction

Subtracts a constant intensity value
such that the non-excluded data is
shifted to zero

Straight line subtraction

Subtracts a straight line that is drawn
between the two y-data points at the
range bounds

Linear fit subtraction

Subtracts the straight line that lies
closest to the sample's y-data, but always below it

Rubber band subtraction

Fits a convex envelope to the spectrum’s underside. See also baseline
nodes.

Advanced baseline
subtraction (deprecated)

Fits a convex envelope with automatic detection of nodes. See also
baseline smoothness. This option is
deprecated. Use rubber band subtraction instead.

Baseline nodes
Additional settings for rubber band baseline.
Baseline nodes are optionally used when baseline correction is set to "rubber
band". Nodes are points of the spectrum which belong to the baseline. The spectrum’s left and right point are nodes by default, as well as each point at the edge
of an excluded region. You can add more nodes, e.g. to fit the baseline tighter to
a concave part of the spectrum.
Baseline smoothness (deprecated)
Additional settings for advanced baseline.
The baseline smoothness value only applies when baseline correction is set to "advanced". The greater the value, the smoother the detected baseline.
Smoothing / Derivatives
Smoothing and derivation are operations to emphasize the information content
of the signal. While smoothing is meant to remove disturbing noise, derivation
separates overlapping peaks into distinct signals. See also smoothing filter.
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Value

Description

None

Disabled

Smoothing only

Removal of noise by smoothing the signal

1st order derivative

Numerical first derivation. Inflection
points in the original signal are resolved to
peaks

2nd order derivative

Numerical second derivation. Shoulders of
overlapping peaks in the original signal are
resolved to peaks

Smoothing filter
Additional settings for smoothing / derivatives
A smoothing filter is required for smoothing and derivation. The smoothing filter
N defines the size of a moving window. The data point in the window's center gets
smoothed by taking its neighboring points into account. The greater N becomes
the more neighboring points from more far away of the window's center are incorporated.
If you have problems getting your data smoothed sufficiently even with the maximum filter length of N=199 you should consider data thinning or other resampling
options to reduce the total number of data points.
Standardization
Standardization makes data of different scales comparable.
Value

Description

None

Disabled

Min-Max-Normalization

Scales intensity to values between 0
and 1

Area Normalization

Scales intensity so that the area below
the spectrum is 1

SNV Normalization

Scales intensity so that the standard
normal variate is 1

Peak Normalization

Scales intensities so that the intensity of
a reference peak is 1

Reference Peak Range
This option is used when the standardization mode is set to “Peak Normalization”.
It defines the x-range (smallest and largest x-value) which contains the reference
peak for scaling. The largest value within the range is used as scaling factor.
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Hard Model Settings

Note: All settings described in this Section are both, preferences and model-specific settings. In the Preferences Editor, settings are treated as defaults for new
models. After copied to a new model, settings can be modified for each model individually in the Model Properties Panel.

Peak Fitting
Default Peak Type
The default peak function used when adding new peaks to the hard model.
Value

Description

PseudoVoigt

The Pseudo-Voigt function is a linear combination of
Gaussian and Lorentzian functions:
𝑉 = 𝛼 [𝛽 ∙ exp (− ln(2)

(𝑥−𝛿)2
𝛾2

𝛾2

) + (1 − 𝛽) (𝑥−𝛿)2 +𝛾2]

𝛼 = peak maximum at the peak’s center position
𝛽 = Gaussian-Lorentzian-ratio between 0 and 1
𝛾 = half width at half maximum (HWHM)
𝛿 = center position
x = independent variable
The area under the peak curve is:
𝐴=𝛼∙𝛾 ⌊

Auto-Fit Mode
Value

𝛽
√ln(2)⁄𝜋

+ (1 − 𝛽)𝜋⌋

Description

Regular
(Sequential)

Peak models are added and fitted one by one.
The next peak model will be added at the position of the largest positive residuals. This method
is slow because all peaks are fitted every time a
new peak is added, but sometimes this leads to a
better accuracy of the final fit.

Fast
(Simultaneous)

Peak models are added and fitted in groups.
Peak positions are determined by means of a
peak search. This method is fast and often leads
to more physically reasonable results.
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Description

Enabled

Residuals between model and sample are weighted by
the absolute sample intensity to take into account that
noise typically scales with signal intensity, i.e. residual
noise on top of a large peak might be even larger than
small residual peaks. This way, "noisy peaks" are suppressed and the next peak model is more likely to be
added at the position of a real peak.

Disabled

The next peak model is added at the position of the
largest positive difference between model and sample.

Absolute Parameter Constraints
Absolute parameter constraints limit values of hard model parameters when being adjusted
automatically during model fitting. However, parameter constraints can easily be violated by
manually setting parameter values outside the constrained range or by tightening constraints
such that previous model parameters are then out of bounds. Make sure to not accidentally
violate parameter constraints manually.
Caution: Model fitting may not work correctly for hard models with violated parameter constraints.
HWHM
Absolute lower and upper bounds for the HWHM parameter.
Gaussian Part
Absolute lower and upper bounds for the peak’s Gaussian part parameter.

Component Fitting
Fitting Mode
The fitting mode controls the extent of model flexibility (free parameters besides
component weights) during component fitting as part of the following analyses:
• component fitting analysis
• prediction and validation using an HM calibration
The fitting mode is not used in the following cases in which component fitting is
also performed:
• HMFA analysis: here, the component fitting mode is always "no interaction"
• automatic parameter adjustments during hard modeling: here, component fitting is controlled by a separate choice of parameters
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Component fitting modes are named after the extent of molecular interaction
among components in the mixture. Molecular interaction is supposed to be responsible for peak variations.
Value

Description

No
Interaction

Only component weights and baseline parameters
are adjusted. This is a linear fit and thus very fast.

Low
Interaction

Component weights (W), component shifts (S), and
baseline (B) parameters are adjusted. The component shift parameter shifts all peaks of a component at once.

Medium
Interaction

WSB parameters and individual peak positions are
adjusted. The actual number of individual peaks being shifted is controlled by the "No. of Considered
Peaks" option (see below).

High
Interaction

WSB parameters and all peak parameters are adjusted. The actual number of individual peaks being
shifted and deformed is controlled by the "No. of
Considered Peaks" option (see below).

Very High
Interaction

All model parameters are adjusted simultaneously.
This fit is very time-consuming and can only be recommended for very small models.

No. of Considered Peaks
This setting only takes effect if component fitting modes "medium interaction" or
"high interaction" are selected. In both cases, the number of actually adjusted
peaks is limited by this setting. The fitting algorithm only considers the most important peaks, i.e. peaks which have the largest influence on improving the fit. Increasing the number of considered peaks increases computational time but not
necessarily increases the accuracy of the fit because also insignificant peaks will
be fitted. As a rule of thumb, the number of considered peaks should be as high as
the number the significant/large peaks in each component model.
Initialization of Fit
Component fitting is an iterative process. This setting can be used to change starting values of model parameters.
Value

Description

none

Component fitting starts with current parameter
values.

Solutions for Process Analytics & Control Technology

3 - PEAXACT USER INTERFACE

linear fit

39

A linear fit of component weights and baseline parameters precedes the actual component fit. Exception: no preceding linear fit is performed when
component fitting mode is set to "no interaction"
which is a linear fit itself.

Component Weight Threshold
Component models with a component weight below the threshold will not be adjusted during component fitting. The threshold value applies if one would scale
the model to a maximum y-value of 1. The threshold value could then be interpreted as a fraction of 1.

Relative Parameter Constraints
Relative parameter constraints define how much a parameter is allowed to vary relative to its
starting value. Absolute parameter constraints (see above) will always be honored.
Component Shift
Relative bounds (in parameter units) for the component shift parameter.
Position
Relative bounds (in parameter units) for the peak position parameter.
Max
Relative bounds (in percent) for the peak maximum parameter.
HWHM
Relative bounds (in percent) for the peak HWHM parameter.
Gaussian Part
Relative bounds (in parameter units) for the peak’s Gaussian part parameter.
Constant Peak Intensity
This constraint results from the physical observation, that for a constant concentration, the peak intensity (peak area) is constant even if the peak shape changes,
e.g. due to molecular interactions. Therefore, peak shape parameters (maximum,
HWHM, and Gaussian part) are coupled. This should be considered when changing
relative constraints for these parameters.

Optimizer Options
Optimizer options are for advanced tuning and should be modified by experienced users only.

Linear Fitting
Linear fitting options apply to component fits (no interaction) and HMFA component analysis. It is recommended not to change the default settings.
Max. Iterations
Stopping criterion. Optimization stops after a maximum number of iterations.
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Objective Function Tolerance
Termination tolerance. Optimization stops only if objective function value drops
below the tolerance. The value should be between 1e-10 and 1e-15.

Nonlinear Fitting
Nonlinear fitting options apply to peak fits and component fits (low to very high interaction).
Max. Iterations
Stopping criterion. Optimization stops after a maximum number of iterations.
Objective Function Tolerance
Termination tolerance. Optimization stops only if objective function value drops
below the tolerance. The value should be around 1e-6.
Parameter Tolerance
Termination tolerance. Optimization stops only if progress in improving parameters drops below tolerance. The value should be around 1e-6.
Constrained Fitting Algorithm
This option only applies to constrained optimization problems, e.g. components
fits with interaction high and very high.
Value

Description

Active-set Moderate progress during all iterations. This algorithm
typically stops due to small progress. Default termination tolerances should be used.
SQP

Thorough optimization. Good progress at the beginning, steady progress at the end. This algorithm typically stops when the maximum number of iterations is
reached. Therefore, the maximum number of iterations should be chosen carefully.

Constraint Violation Tolerance
Termination tolerance. Optimization stops only if constraints are violated by less
than the tolerance. The value should be around 1e-2. This option only applies to
constrained optimization problems, e.g. components fits with interaction high
and very high.

3.3

Working in Sessions

The PEAXACT workspace is referred to as session. A session contains settings (see Session
Profile) that can be adjusted to the kind of data you want to work with, e.g. Raman spectra
or NMR spectra. You can save the workspace to a session file to keep all data in one place or
to continue working at a later time.
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New Session

Menu bar:

File > New Session > (Profile)

When starting a new session, you have to pick a session profile to work with. Starting a new
session clears the current workspace and resets the desktop to its initial state: all windows
except the main window are closed, all model files are closed, and all data sets are unloaded.
You will be asked to automatically save the current session first.

3.3.2

Open Session

Menu bar:
Menu bar:

File > Open Session > Load Session File…
File > Open Session > …

You can choose between loading a session from file (by using the File Dialog) and reloading
a recently opened session.
When opening a session file, the current session is closed and the workspace of the opened
session is restored.

Drag and Drop
A fast way to open a session file is by using drag & drop. Drag a single session file from the
Windows Explorer (e.g.) and drop it into the Model Tree Panel or the Data Sets Panel. Note:
if you drag & drop multiple files, PEAXACT ignores any session files among them and tries to
open model files or data files instead.

Command Line Alternatives
peaxact -session <file>
peaxact -restore

When starting PEAXACT from the command line, you can pass additional parameters to either open a certain session file or to restore the most recently saved session.

What is Restored from Session Files?
•

•

Master models are restored exactly to the state when the session was saved. If at that
time any model had unsaved changes, it will be marked unsaved again after loading
the session. Modeling history is not restored, i.e. modeling steps from before the session was saved cannot be reverted using Undo/Redo.
Data sets are restored exactly to the state when the session was saved, including filenames of data files. When you move or rename these files on your hard disk, filenames
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stored in the session still point to the old location and need to be updated after the
session is restored (see below).
All component fits of hard models to data sets are restored.
Selected and active elements of the Model Tree Panel and Data Sets Panel are restored. Therefore, the Properties Panel and Plot Panel also are restored to their previous state.
The session profile is NOT restored! This is going to change in a future version.

Caution with Models Restored from Sessions!
A model restored from a session file must be treated with care, especially if
•
•

multiple sessions exist containing the model at different building stages
the model was modified and saved to file after the session was saved

In these cases, it is possible to restore a model from a session file which in the meantime has
been replaced by a newer version. You can choose whether to reload the newer model or
continue working with the one contained in the session file.

Update Missing Data Files
Data sets stored in a session file contain references (URIs) to data files from the moment the
session was saved. When you move or rename these data files on your hard disk filenames
stored in the session still point to the old locations. After reloading a session, you may have
to update these file references. PEAXACT informs you to update missing files when it tries to
load data from such a file.

3.3.3

Save Session

Menu bar:

File > Save Session As…

Use the File Dialog to browse directories and select a filename for the session to be saved.
When saving a session file, the current workspace is written to the hard disk.
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Auto-Saving
The current session can be saved automatically to a special directory on PEAXACT shutdown
(see preferences).

What is Stored in Session Files?
•

•
•
•

All opened master models including changes made during runtime are saved to the
session file. Please note that unsaved model changes are not saved to model files.
Therefore, changed models will still be marked unsaved when the session is restored
from file.
Loaded data sets
Component fits
Selected and active elements of the Model Tree Panel and Data Sets Panel

3.4

Model File Management

3.4.1

About Models

What are Models?
A model is a set of parameters used by PEAXACT algorithms to solve analysis tasks, e.g. predicting concentrations from measured spectra. A PEAXACT model is also called master
model. The master model contains sub-models which group parameters:
•
•
•
•

Pretreatment model: parameters for data manipulation
Integration model: parameters for peak integration
Hard model: parameters of hard models
Calibration model: parameters for quantitative analyses

Almost everything you do with PEAXACT is related to models. You use PEAXACT to create
and edit models, load and save models, and apply models to data for analysis purposes.

Modeling and Analysis
The lifetime of a model passes at least two stages:
•

•

First, an analysis method must be chosen and appropriate model parameters must be
set. This process is called modeling. The amount of information that has to be provided during modeling depends on the analysis method. For instance, calibration
methods require a calibration model; hard modeling methods require a hard model.
After the model has been created, it can be utilized for data analysis.

Solutions for Process Analytics & Control Technology

3 - PEAXACT USER INTERFACE

44

Browsing the Model Structure
The Model Tree Panel is a graphical control designed for browsing the master model's structure. It quickly gives an overview of all the sub-models and their content, e.g.
•
•
•
•

What kind of data pretreatments are used?
Does an integration model exist? How many integration ranges are defined?
Does a hard model exist? Which components are modeled?
Is the model calibrated?

Getting Access to Model Parameters
The model tree can be used to select any element of the master model and then get displayed
additional information about that element in the Properties Panel.
For most model elements, the Properties Panel gives access to model parameters and their
values. In particular, when clicking the Master Model item in the Model Tree, the Properties Panel displays a summary of the most important parameters in a tabular report.

Model File
The model file is a physical file on the hard disk which is written by PEAXACT and stores all
master model parameters.

Exporting Reports
Menu bar:

File > Export > …

Model reports are tabular or graphical representations of model parameters. Model reports
can be re-created at any time because the necessary information is persistently stored within
the model file. PEAXACT can export reports to different output formats such as XLS or PDF.
The following model reports are available:
Model Summary
This report contains the same information as shown in the Properties Panel which
is a summary of model parameters.
Model Details
For documentation purposes it is recommended to export the model details report. It's a full report of all model parameters.
Hard Model XY Data
This report contains x-values and y-values of the hard model. This data can be used
to reproduce plots of the hard model similar to those shown in the Plot Panel.
Plot
This report exports the current content of the Plot Panel to an image file format.
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New Model

Toolbar:
Menu bar:
Hot key:
Context menu:

File > New Model
CTRL + N
Model Tree Panel > New Model

A new master model is added to the Model Tree Panel.

Model Name
The new model's name is "Untitled" by default. If an opened model already has this name, a
consecutive number is added.
A model is always named after its filename. To rename a model in PEAXACT, save it under a
new filename. To rename a model outside PEAXACT, simply rename the file. Caution: Do not
change the file extension!

Initial Settings
Each time a new model is created, initial settings are copied from the then-active session profile. You can later modify model settings of each model individually in the Model Properties
Panel.

3.4.3

Open Model

Toolbar:
Menu bar:
Hot key:
Context menu:
Drag & drop:

File > Open Model…
CTRL + O
Model Tree Panel > Open Model…
from Explorer to Model Tree Panel

The File Dialog can be used to browse directories and select one or more model files to be
opened. Choose a file filter from the pull-down list to localize certain model files. Opened
models are added to the Model Tree Panel.

Drag and Drop
A fast way to open model files is by using drag & drop. Drag any files from the Windows Explorer (e.g.) and drop them into the Model Tree Panel. Hint: If your directory contains many
different files you can simply select all files and drop them to the Model Tree Panel. PEAXACT
automatically filters out model files. You may also drag & drop directories in order to load all
model files from the directory.
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If any model is active while dropping files to the Model Tree Panel, you will be asked whether
to open these files or to import components into the active model.

Reload Open Model
If you open a model file that is already opened, you will be asked whether to reload the model
or discard all unsaved changes (if any).

3.4.4

Close Model

Menu bar:
Hot key:
Context menu:

File > Close Model
CTRL + W
Model Tree > Master Model Item > Close

The active model file is closed. The model is removed from the Model Tree Panel and the next
available model becomes active.

Unsaved Changes
If the active model contains unsaved changes, you will be asked to save the model first. Otherwise, the model file is closed directly.

3.4.5

Close All

Menu bar:

File > Close All

All model files are closed. This is a fast way to clear the Model Tree Panel. If any master model
contains unsaved changes, you will be asked whether to save them or discard changes.

Closing Models on Shutdown
All models will be closed when quitting PEAXACT. Respectively, you get the chance to save
unsaved changes.

Solutions for Process Analytics & Control Technology

3 - PEAXACT USER INTERFACE

3.4.6

47

Save Model

Toolbar:
Menu bar:
Hot key:
Context menu:

File > Save Model
CTRL + S
Model Tree > Master Model Item > Save

The active master model is saved to its file. If the model has never been saved before
PEAXACT falls back to "Save As".

3.4.7

Save Model As

Menu bar:
Context menu:

File > Save Model As…
Model Tree > Master Model Item > Save As…

The File Dialog can be used to browse directories and select or enter a filename for the model
to be saved.

Overwriting Existing Files
As a precaution, you cannot save a master model to a file of another model that is currently
opened in PEAXACT. You have to close the other model before overwriting its file.

3.4.8

Duplicate Model

Menu bar:
Context menu:

File > Duplicate Model
Model Tree > Master Model Item > Duplicate

An exact copy of the active master model is created. The new model is added to the Model
Tree Panel. The duplicate gets the name of the source model plus a consecutive number.

Using Duplicates
Using duplicates is useful if you already have a populated model and want to compare the
effects of different model settings without changing the original model each time.

Solutions for Process Analytics & Control Technology

3 - PEAXACT USER INTERFACE

3.5

48

Data Set Management

3.5.1

About Data Sets

What are Data Sets?
A data set is a collection of data that belongs together. In PEAXACT, each data set consists
of exactly one sample and optional features.
One may think of the data set as a row of a table. The table's columns then represent different
pieces of information. The full table of all data sets is referred to as data table.

The Sample URI
Data sets only contain references to samples. The samples' xy-data are stored in data files.
Therefore, each reference simply points to a sample in a file. The reference is composed of a
filename and – because the file may contain more than one sample – an access ID. Together,
filename and access ID represent a uniform resource identifier (URI) which unambiguously
identifies a specific sample. Learn more about URIs in Section Data Table File.
Example URI:
C:\Program files\S-PACT\PEAXACT\data\HMFA\analysis\001min.CSV#1

Data Set Name
In order to make it easier to refer to a certain data set, each one is given a data set name. The
name is a shortened URI, namely the filename's base name and the access ID. Data set names
are often used in PEAXACT, e.g. in report dialogs, in result files, or as entries in the Data Sets
Panel.
Example Data Set Name:
001min.CSV#1

Features
The term feature refers to any kind of information that is optionally attached to a data set.
Each feature is denoted by a name and corresponds to a column in the data table with the
feature name being the column's title.
Data set features are used in several ways:
•
•
•
•

coloring and arranging 2D and 3D plots in the Data Inspector
sorting data sets in the Data Sets Panel
plotting results vs. features (e.g. in analysis reports)
changing the treatment of data sets by assigning special tags
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providing reference values for model calibration and validation

Features are either predictive, i.e. they can be calibrated and later predicted for unknown
samples, or non-predictive. Non-predictive features are recognized by the following feature
names: Usage, Time, Timestamp, Location. These features are treated specially:
Usage
The Usage feature influences the treatment of data sets during modeling and
analysis. Values are confined to a predefined list:
Value

Description

unspecified

No special treatment; data set is used in a
normal manner.

train

Data set is explicitly labeled as training sample for calibration. This tag only affects calibration. It has no effect otherwise.

test

Data set is explicitly labeled as test sample
for calibration. This tag only affects calibration. It has no effect otherwise.

ignore

Data set is ignored during calibration and
analysis.

Time / Timestamp
Values of the Time and Timestamp features are interpreted as measurement
times. While the Time feature can hold any numeric value, the Timestamp feature
must be a date (YYYY-MM-DD), a time (hh:mm:ss), or both (YYYY-MM-DD
hh:mm:ss).
Location
Values of the Location feature are interpreted as measurement locations. Measurement locations can be used for the regression of location-dependent calibration models.

Data File and Data Table File
Both, data files and data table files are physical files on the hard disk. Data files contain
xy-data of one or multiple samples and are typically generated by measurement software.
Data table files contain at least one data set and are typically created by the user, either with
PEAXACT or with Excel.

Getting Access to Data Sets
The Data Sets Panel can be used to select any data set and then get displayed additional information about that element in the Properties Panel.
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Load Data Files

Toolbar:
Menu bar:
Hot key:
Context menu:
Context menu:
Drag & drop:

Data > Load…
CTRL + L
Data Sets Panel > Load…
Model Tree > Hard Model Item > Load Associated Sample
from Explorer to Data Sets Panel

The File Dialog can be used to browse directories and select one or more data files to be
loaded. Choose a file filter from the pull-down list to localize certain data files.

Drag and Drop
A fast way to load data files is by using drag & drop. Drag files from the Windows Explorer
(e.g.) and drop them into the Data Sets Panel. Hint: If your directory contains many different
files you can simply select all files and drop them to the Data Sets Panel. PEAXACT automatically filters out data files. You may also drag & drop directories in order to load all data files
and data table files from the directory.

Creating Data Sets from Data Files
When loading a data file, PEAXACT scans its content for samples, creates URIs, and generates a data set for each sample. URIs are created automatically from the filename, the sample's number within the file, and optionally a block name (OPUS-files) or frame number (other
4D data files). See also Section Data Table File for further information about URIs.
The data set is added to the Data Sets Panel only if
•
•

it is a new data set, i.e. none of the loaded data sets has the same URI
in case of OPUS-files, the block name matches the block name filter (see preferences)

3.5.3

Load Data Tables

Toolbar:
Menu bar:
Hot key:
Drag & drop:

Data > Load Table…
CTRL + T
from Explorer to Data Sets Panel

The File Dialog can be used to browse directories and select data table files to be loaded.

Solutions for Process Analytics & Control Technology

3 - PEAXACT USER INTERFACE

51

Drag and Drop
A fast way to load data tables is by using drag & drop. Drag files from the Windows Explorer
(e.g.) and drop them into the Data Sets Panel. You may also drag & drop directories in order
to load all data files and data table files from the directory.

Loading Data Sets from Data Tables
When loading a data table file, PEAXACT scans it for Sample URIs, checks if they are valid,
and generates data sets from each table row. If a data set is not loaded yet, i.e. if there is no
data set in the Data Sets Panel with the same Sample URI, then it is added to the Data Sets
Panel. Existing data sets are updated, i.e. new information loaded from the table is merged
with the existing information.

3.5.4

Unload Selected Data Sets

Menu bar:
Hot key:
Context menu:

Data > Unload Selected Data Set(s)
CTRL + U
Data Sets Panel > Unload Selection

All selected data sets are instantaneously unloaded and removed from the Data Sets Panel.
If the active data set gets removed the next available data set becomes active. Component
fits to any of these data sets are removed along with the data sets.

3.5.5

Unload All

Menu bar:

Data > Unload All

All data sets are unloaded at once. This is a fast way to clear the Data Sets Panel. All component fits are removed as well.

3.5.6

Save Data Table

Menu bar:
Menu bar:
Context menu:

Data > Save Data Table…
Data > Data Inspector… > Data Table Editor >
Data Sets Panel > Save as Data Table…

All selected data sets are exported to a data table file. The File Dialog can be used to browse
directories and select or enter a filename.
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Update Missing Files

Menu bar:
Data > Update Missing Files
Data Sets Panel: Activate data set whose data file is missing
All data sets are checked for URIs pointing to missing files on the hard disk. If any are found,
the File Update Dialog appears (see Figure below) which can be used to either relocate these
files or unload affected data sets.
URIs happen to point to missing files if data files are moved or renamed on the hard disk while
being loaded in PEAXACT or if a session file is restored which refers to data files that have
been moved or renamed since the session file was saved.

Relocate
Relocating comprises two steps:
•
•

Relocating the next missing file, i.e. select a new target directory and target filename
using the File Dialog.
If possible, automatically relocating more missing files with matching names from the
source directory to the selected target directory.

Note: Relocating data files is fast and easy if files were only moved from one directory to another directory. Try to avoid moving data files from one directory to
many different directories. Also avoid renaming data files.
Both steps execute until either all missing files are relocated or the user cancels.
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Unload
Unloading removes all data sets which are pointing to missing data files.

3.5.8

Edit Data Sets

Editing data sets refers to adding, removing, and modifying features of data sets. It is not
possible to edit a data set's sample directory or filename unless the file location is invalid (in
which case you should update missing files).

Edit Data Sets with PEAXACT
PEAXACT comes with its own integrated Data Table Editor which is part of the Data Inspector.
Menu bar:
Menu bar:
Context Menu:

Data > Data Inspector… > Data Table Editor
Analysis > Data Inspector… > Data Table Editor
Data Sets Panel > Data Inspector > Data Table Editor

In addition, the context menu of the Data Sets Panel offers shortcuts to setting the Usage
feature and fully removing all features. Both actions are applied to selected data sets.
Context Menu:
Context Menu:

Data Sets Panel > Set Usage > …
Data Sets Panel > Remove Features

Edit Data Sets with Microsoft Excel
Microsoft Excel can be used as an external editor for data sets. You can use Excel to create
and edit data table files and then load these data tables in PEAXACT. Because Excel is a powerful spreadsheet editor this is a convenient way to edit data sets. However, keep in mind that
you have to load the data table file in PEAXACT in order to import its changes.
You need to consider the data table formatting rules in order for PEAXACT to read the file
correctly. Beside these rules you are free to use all Excel functionalities like formulas, diagrams, filters, conditional formatting, and so on.

Common practice
A typical procedure of editing data sets involves creating an initial data table file with
PEAXACT and then editing the file with Excel:
•
•
•
•
•

Load data files in PEAXACT
Select all data sets in the Data Sets Panel and open the Data Inspector
Save the data table (this creates a data table file that contains Sample URIs)
Use Excel to edit the data table file (e.g. add concentrations)
Load the final data table file in PEAXACT to import features to existing data sets.

Solutions for Process Analytics & Control Technology

3 - PEAXACT USER INTERFACE

3.5.9

54

Sort Data Sets

Context Menu:

Data Sets Panel > Sort Selection by

Sorting is applied to selected data sets. Data sets can be sorted by name, usage, or any other
available data set feature.

Sort order
Unsorted data sets are sorted in ascending order (a to z, 0 to 9) when sorted once, and in
descending order when sorted a second time. The sort order has no effect on any analysis
results but sometimes on how the results are displayed.

3.5.10 Create Mean Sample
Menu bar:

Data > Create Mean Sample…

A mean sample can be calculated if:
•
•
•

at least 2 samples are selected in the Data Sets Panel (otherwise the feature is disabled)
all selected data sets have valid data files (otherwise you will be prompted to update
missing files)
all selected samples have identical x-axes (otherwise an error is displayed)

The mean sample is the sum of these samples divided by their number.

You can optionally apply data pretreatments from the active model and enable grouping. You
have to choose a filename for saving the mean sample. Finally, a new data set is added to the
Data Sets Panel.

Data Pretreatment
If a master model is active, its pretreatment model can be applied to all selected samples
before the mean sample is calculated. Tick Apply data pretreatments to use this option.
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Note: Do not enable this option if you later intend to analyze the new sample by a
model because could produce unexpected results (double pretreatments).

Grouping
Without grouping a single mean sample is created from all samples.
If you choose a grouping feature, a separate mean sample is created for each group (group =
samples having the same feature value). Samples with missing feature value are ignored. For
example, you can use grouping to create a single mean sample for each group of repeated
measurements.

3.5.11 Create Representative Sample
Menu bar:

Data > Create Representative Sample…

A representative sample is calculated if:
•
•
•

at least 2 samples are selected in the Data Sets Panel (otherwise the feature is disabled)
all selected data sets have valid data files (otherwise you will be prompted to update
missing files)
all selected samples have identical x-axes (otherwise an error is displayed)

The representative sample is similar to the mean sample but it is only calculated from the
most different samples among the selected samples. The representative sample typically will
contain all peaks of all samples in a very pronounced manner. Therefore, it is a suitable sample for creating a representative hard model for HMFA.

You can optionally apply data pretreatments from the active model. You have to enter the
number of different samples and a filename for saving the representative sample. Finally, a
new data set is added to the Data Sets Panel.

Data Pretreatment
If a master model is active, its pretreatment model is applied to all selected samples before
the representative sample is calculated.
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Note: Do not enable this option if you later intend to analyze the new sample by a
model because could produce unexpected results (double pretreatments).

Number of Samples
While the selection of the most different samples from the set of selected samples is done
automatically, you still have to enter the number of different samples to consider. The number should correspond to the number of chemical compounds in your data.

3.6

Reporting of Results

The Report Window is a graphical tool for visualizing and exporting data of any kind, e.g.
analysis results. All PEAXACT report windows have a similar layout and common functionalities which are explained in this section. Variations from the typical layout and custom features are explained in separate sections dedicated to the individual report windows.

Typical Layout of Report Windows

Toolbar
Export report as shown in the Report Panel to file. The exact list of available file formats
depends on the type of report, but in general, graphical reports can be exported to image files
while tabular reports can be exported to text or spreadsheet files.
Copy report to clipboard. Graphical reports are copied as rendered images or vector images (see preferences_Report_Settings) while tabular reports are copied as text.
Open Print Preview.
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Open Preferences Editor
Graphical Reports only
Full zoom, Full y-zoom
Zoom tools (2D plots only), zoom in or out on a plot
Pan tool (2D plots only), move the view of a graph
Data Cursor tool, read data directly from a graph by placing Data Tips in a plot
Profile Cursor tool (2D plots only), display y-values of overlapping plots at an x-position
Rotate tool (3D plots only), rotate the orientation of a graph
Show/Hide color bar
Note: The exact set of available toolbar icons depends on the specific Report Window. However, same icons have the same meaning each time.
Zoom
, Pan , Data Cursor , Profile Cursor , and Rotate are interactive tools for
graph and plot manipulation. Before using them, you need to enable these tools, either by
clicking the toolbar icon, or by using the short keys Q, W, E, R, F, and T. Pressing the Escape
key disables all tools.

Report Selection & Customization
The report to be displayed in the Report Panel can be chosen from a pull-down list located at
the top-right of the Report Window. Each individual Report Window has a very specific list of
available reports.
Most reports can be customized in various ways using some controls located at the right of
the window.
Changing Report Appearance
The appearance of reports (e.g. font size, visible elements of graphs) is controlled by several
adjustable preferences. You can reach the Preferences Editor from the toolbar.
Editing Titles and Labels
All titles and labels of graphical reports can be edited when clicking on them.

Note that your text is processed by a TeX interpreter, i.e. you can use ^ for superscripts, _ for
subscripts, { } for grouping. Also, you can use special commands for Greek letters (\alpha,
\beta, \gamma, \Gamma, …). When finished editing, press the Escape key or click anywhere outside the text field.
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Note: User edited titles and labels are replaced by default text each time the selected report changes. Therefore, it is recommended to customize titles and labels
as a final step before exporting the report to a file.
Positioning of Legends
Legends in graphical reports are positioned automatically to least interfere with the plots.
However, you can reposition legends interactively by dragging them to the desired location.

Print Preview Dialog
The Print Preview is a dialog box showing the graphical report as it will print. A scaled version
of the report displays in the right-hand pane of the window.
Use the Print Preview dialog box, shown below, to control the layout and appearance of
graphical reports before sending them to a printer or print file.

Print Preview Dialog
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Data Inspector

Menu bar:
Menu bar:
Context Menu:

Data > Data Inspector…
Analysis > Data Inspector…
Data Sets Panel > Data Inspector

The Data Inspector is a graphical tool designed for editing and visualizing data sets. For this
purpose, the Data Inspector contains two tabs:
•
•

Data Table Editor for editing features of data sets
Data Plotter for visualizing samples and features in various 2D and 3D plots.

The Data Inspector does not require a model; it operates on data sets alone and can therefore
be used for data-driven analysis. You typically use the Data Inspector to visually inspect
measured samples and manage features before you start with modeling.
To learn more about data sets and data tables, see About Data Sets.

Starting the Data Inspector
Each time you open the Data Inspector, all data sets selected in the Data Sets Panel are
loaded into the Data Inspector and the Data Table Editor and the Data Plotter are updated
accordingly. To load different data sets, change the selection in the Data Sets Panel and open
the Data Inspector again.
Note: Restarting the Data Inspector refreshes the content of the Data Table. Any
unsaved changes made in the Data Table Editor will get lost.

Closing the Data Inspector
When closing the Data Inspector while the Data Table Editor has unsaved changes, you will
be asked whether to apply these changes to data sets.

3.7.1

Data Table Editor

The Data Table Editor is a tool for modifying features of data sets. Each feature is represented by a column in the data table. The first two columns are not editable; they contain the
sample's directory and filename.
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1
2
4

3
5
6
7

9

10

Data Inspector – Data Table Editor
(1) Toolbar
(2) Tabs
(3) Data Table, consists of columns:
•
•
•
(4)
(5)
(6)
(7)
(8)
(9)
(10)

Directory: path of data file (not editable)
Sample: data set name (not editable), printed in red if file is missing
any number of feature columns (editable)

Actions applicable to selected rows
Actions applicable to feature columns: add, remove, hide, show, rename
Text field for adding new feature columns
Pull-down menu for removing feature columns
Feature list (list of visible and invisible features)
Apply button: copy table changes to data sets
Close button: close Data Inspector

Export Options
The Toolbar of the Data Table Editor contains two export tools.
Export table to a Data Table File.
Export table to clipboard
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In both cases, the content of columns Directory and Sample is merged and exported as a single column representing Sample URIs. For more information about Sample URIs see Section
Data Set Management.
Note: When exporting the Data Table to a file, all URIs pointing to subdirectories
of the table file location are converted to relative paths.

Edit Table
You can edit the table by clicking into a table cell and modifying the value. Use the Enter
(Escape) key to accept (discard) your changes. Press the Tab key or the arrow keys to accept
changes and move the cursor to an adjacent cell. You can use the cut/copy/paste/delete keys
to manipulate the table.
Note: Changing the table does not yet change the underlying data sets. You have
to click the Apply button to copy tables changes back to data sets.
Except for the following special columns, all values must be numeric. If an invalid value is entered it is discarded and the previous value is restored.
Directory
This column is not editable. It shows the directory of the sample file.
Sample
This column is not editable. It displays the data set name (sample filename and
access ID). If the value is printed in red, the file does not exist in the given directory.
Usage
Values of the Usage feature are confined to a predefined list and can be chosen
from a pull-down menu.
Timestamp
Values must be entered as dates (YYYY-MM-DD), times (hh:mm:ss), or a combination of both (YYYY-MM-DD hh:mm:ss).

Alter Selected Table Rows
From the top-right panel of the Data Table Editor you can apply some actions to all selected
data sets of the table. A data set counts as selected if any cell in the corresponding row is
selected.
Change Usage
Choose a value from the "Change Usage" pull-down menu in order to set the same value in
all selected data sets. The Usage column is added if it is not visible.
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Set Timestamp
Click the "Set Timestamp" button in order automatically set the value of the Timestamp column. The column is added if it is not visible. Existing values will be overwritten. The value is
read from the data file content if available, or from the file system otherwise.
Convert Timestamp to Time
Choose data sets and click the “Timestamp > Time” button in order to convert timestamps to
relative time values. A window will open which allows you to select a reference timestamp for
time = 0 and a time unit. All time values will be calculated relative to the reference timestamp.
Remove Rows
Click the "Remove from Table" button in order to remove all selected rows from the table.
Note that removing table rows does not remove data sets from the Data Sets Panel.
Sort Rows
Rows can be sorted by clicking on a column header. Clicking multiple times toggles the sort
order. Hold the CTRL-key while clicking multiple column headers enables multi-level sorting.
Filter Rows
Rows can be filtered using the filter editor below the column header. Choose a value from the
drop-down list or enter the desired value into the text field. Only rows matching the filter will
be displayed. Filtering values may also be logical expressions such as “> 0” or “<>ignore”
•
•
•
•
•
•

>
>=
<
<=
=
<>

greater than filter
greater than or equal filter
less than filter
less than or equal filter
equal filter
not equal filter

Alter Table Columns
From the bottom-right panel of the Data Table Editor you can perform some actions to modify table columns.
The table layout is controlled by the feature list (8). You can show (hide) a table column by
placing (removing) the checkmark of the corresponding feature.
Each time the Data Inspector is opened the feature list is automatically updated to only show
available features.
Show / Add Colum
The simplest way of adding a column is by placing a checkmark in the feature list in order to
show a hidden feature. However, if the feature name you wish to add does not exist in the
list, you can enter a new name in the text field (6) and press the "+" button afterwards. The
name is added to the feature list (8) and a new column is added to the table.
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Feature names must be unique, i.e. you cannot add the same feature twice. If you try to add
a feature that already exists in the feature list but is currently hidden, the column is simply
made visible again.
Names of predictive features are not case sensitive; names of non-predictive features are.
See Section About Data Sets for a list of non-predictive feature names. If you enter a nonpredictive feature name it is automatically converted to upper case syntax (e.g. "Timestamp"
instead of "timestamp").
Hide / Remove Column
By unchecking its checkbox in the feature list columns can be hidden temporarily. In order to
permanently remove columns, choose a feature name from the pull-down menu (7) and press
the "-"-button afterwards. The corresponding column will be removed from the table and
from the feature list (8).
Rename Column
You can change a feature's name in the feature list (8).
If you try to rename a feature to another name in the list, you have to decide whether to replace or merge column values.

Note: You can neither change the name of feature "Usage" nor rename any other
feature to "Usage"
Re-arrange Columns
Table columns can be re-arranged by dragging a column header and moving the column to
the desired position.
Resize Columns
The width of the column can be changed by dragging its border to the desired position. You
can also auto-adjust the column width by double clicking the border.

3.7.2

Data Plotter

The Data Plotter generates customizable graphical reports of xy-data and data set features.
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The layout of the Data Plotter matches the typical layout of a Report Window (see for a description of functionalities common to all Report Windows). This Section focuses on specifics
of the Data Plotter Window.
1
2
4

3

5

6

Data Inspector – Data Plotter
(1)
(2)
(3)
(4)
(5)
(6)

Toolbar
Tabs
Report Panel
Plot Selection Panel
Visible Range Panel
Data Pretreatment Panel

Available Reports
The Data Plotter generates the following graphical reports which can be chosen from the Plot
Selection Panel:
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Samples (2D)
2D-plot of xy-data of samples, overlapping
y-axis: Signal Intensity
x-axis: Spectral Axis
colored by: selectable feature

Samples (3D)
3D-plot of xy-data of samples, arranged along the x2-axis
y-axis: Signal Intensity
x1-axis: Spectral Axis
x2-axis: selectable feature
colored by: selectable feature
Intensity Surface
3D-surface plot of signal intensity
y-axis: Signal Intensity
x1-axis Spectral Axis
x2-axis: selectable feature
colored by: Signal Intensity
Intensity Contour
2D-contour plot of signal intensity
x1-axis: Spectral Axis
x2-axis: selectable feature
colored by: Signal Intensity

PCA Scores
2D-plot of principal component (PC) scores
x-axis: score on a selectable PC
y-axis: selectable feature or another score on selectable PC
colored by: selectable feature

Features
2D-plot of any two features of data sets
x-axis: selectable feature
y-axis: selectable feature
colored by: selectable feature
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Report Customization
Axes and Colors
The Plot Selection Panel contains controls for changing axes variables and colors.

1

2

3
4

(1) Select report
(2) Choose axis variable from list of available features. Labels X (or X1/X2) and Y correspond to axes.
(3) Choose coloration variable from list of available features.
(4) Choose color scheme from list of popular color schemes. The "default color" depends
on the selected report and for some reports also on the selected axis variable.
Note: The actual number of visible and editable pull-down controls in the Plot Selection Panel depends on the chosen report.
Visible Ranges
The Visible Ranges Panel contains controls for adjusting visible limits of axis and coloration
variables.
1
2
3

(1) Visible range of variable
(2) Move sliders to change visible range of variable
(3) Show full range if control is ticked; show adjusted range if not ticked
Note: The actual variables shown in the Visible Ranges Panel depend on the chosen
report.
Data Pretreatment
The Data Pretreatment Panel of the Data Plotter contains controls for data manipulations.
The impact of these settings can directly be previewed in the Report Panel.
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1

2

3

(1) Import Button: Import pretreatment settings from active model
(2) Export Button: Export pretreatment settings to active model or to new model
(3) Reset Button: Reset settings to those defined in the active session profile
Pretreatment settings used by the Data Plotter have the same meaning as in the Pretreatment Model. However, the Data Plotter keeps its own instance of settings. You can exchange
settings between the Data Plotter and the active model by using the Import (1) and Export
(2) buttons. On export you can also choose to create a new model.

3.8

Modeling

Modeling is the process of creating a model for data analysis. It is subject to the specifics of a
chosen analysis method. For instance, modeling for peak integration comprises the definition
of integration ranges, while Indirect Hard Modeling comprises the creation of a hard model.
Modeling also deals with data pretreatment and calibration.
This Section explains modeling functionalities of PEAXACT. See Section 3.9 to learn more
about how to use the model for analysis.

3.8.1

Undo & Redo

Menu bar:
Hot key:

Edit Model > Undo / Redo
CTRL + Z / CTRL + Y

Each model keeps a history of its most recent changes (see preferences). You can undo and
redo these modifications step-by-step.
Undo/Redo is model-dependent, i.e. each master model has its own history.

3.8.2

Master Model

The term Master Model refers to the top-level model container that consists of sub-models
and that can be saved to a model file.
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Modification
Properties Panel: Click Model Tree > Master Model Item
The master model itself contains a few properties that can be modified by using the Model
Properties Panel. See the following section for how to modify the sub-models.
Model Description
A free text to describe the model or provide additional information.
Model Report Directory
The suggested default directory for saving reports (e.g. analysis results). The directory can be specified as absolute path (starting with a drive letter or double
slash) or relative path. The latter will be resolved to a path relative to the model's
directory. For more details see Section Report File.

3.8.3

Pretreatment Model

The Pretreatment Model is a sub-model of the master model. It consists of a set of data manipulations which are applied to sample xy-data when the master model is active. Pretreatments defined by different master models never interfere because data are only manipulated
temporarily as long the corresponding master model stays active.

Modification
Properties Panel: Click Model Tree > Data Pretreatment Item
The pretreatment model can be modified by using the Model Properties Panel. For a description of all available settings see Section 3.2.6.

Reset
Menu bar:
Context Menu:

Edit Model > Pretreatment Model > Reset
Model Tree > Pretreatment Item > Reset

The pretreatment model can be reset to preferences defined in the active session profile.
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Interactive Modification of Excluded Ranges
You can use the mouse to interactively modify the bounds of excluded ranges in the Plot
Panel (see preferences). Drag the gray area with the left mouse button to shift the whole excluded range. Drag the boundary line to modify the boundaries. Right-click the area to open
the context menu for more options.

Interactive Modification of Rubber Band Baseline Nodes
If the active master model uses a Rubber Band Baseline, new baseline nodes can be added via
the context menu. You can use the mouse to modify baseline nodes. Drag the black circle
with the left mouse button to shift the position of the node. Right-click the circle to open the
context menu for more options.

3.8.4

Integration Model

The Integration Model is a sub-model of the master model. It consists of one or more integration ranges, each specifying parameters for calculating the signal area within a certain
x-range.

Integration model displayed in Model Tree Panel (left) and Plot Panel (right)
Integration models can be utilized for Integration Analysis and Peak Integration Prediction.
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Add Integration Range

Toolbar:
Menu bar:
Context menu:
Context menu:

Edit Model > Integration Model > Add Range…
Model Tree > Integration > Add Range
Plot Panel > Add Integration Range…

A new dialog appears in order to specify properties of the new integration range such as its
name, its bounds, and the type of baseline.

The integration range should be named after the component whose signal is to be integrated.
The name is also utilized during calibration. Lower bound and upper bound specify integration x-limits; baseline specifies a y-limit for the integrated area. You can choose from 4 baselines types:
•
•
•
•

None: Baseline is zero; integration result may be negative if signal is negative
Offset: Baseline is the smallest y-value within x-limits; integration result is positive
Straight Line: Baseline is a straight line from lower to upper bound; integration result
might be negative
Linear Fit: Baseline is a straight line fitted to signal; integration result is positive
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Baseline types None and Offset (top), Straight Line and Linear Fit (bottom)
Clicking OK adds a new integration range to sub-model "Integration" of the active master
model and refreshes the Plot Panel accordingly.

3.8.4.2

Modify Integration Range

Menu bar:
Edit Model > Integration Model > Rename Range…
Context menu: Model Tree > Integration Range Item
Context menu: Plot Panel > Integration Range Patch
Properties Panel: Select Model Tree > Integration Model Item
Properties Panel: Select Model Tree > Integration Range Item
Plot Panel:
Interactive modification of bounds
Integration ranges can be modified in several ways:
•
•
•

From the menu bar you can rename the selected integration range.
From the context menu (either in the Model Tree or in the Plot Panel) you can rename
the integration range and change the baseline type.
The Properties Panel can be used to modify all integration range properties (name,
bounds, and baseline type).

Interactive Modification
In the Plot Panel you can use the mouse to interactively modify the bounds of an integration
range. Drag the colored area with the left mouse button to shift the whole integration range.
Drag the dashed line to modify the boundaries. Right-click the area to open the context menu
for more options.
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Remove Integration Range

Menu bar:
Context menu:
Context menu:

Edit Model > Integration Model > Remove Range
Model Tree > Integration Range Item> Remove
Plot Panel > Integration Range Patch> Remove

From the menu bar and from the context menu (either in the Model Tree Panel or in the Plot
Panel) you can remove the selected integration range. You can also select an integration
range item in the Model Tree Panel or its graphical representing in the Plot Panel and press
the delete key.

Remove All Integration Ranges
Context menu:

Model Tree > Integration Model Item > Remove

You can remove all integration ranges at once by removing the full integration model.

3.8.5

Hard Model

The Hard Model is a sub-model of the master model. The hard model is a mathematical representation of a sample. The model contains parameters which are to be determined during
modeling.
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Hard model displayed in Model Tree Panel (left) and Plot Panel (right)
Hard models can be utilized for Hard Modeling Factor Analysis, Component Fitting Analysis,
and Indirect Hard Modeling Prediction.

Nomenclature
When working with hard models, you should be familiar with the following wording:
Hard Model
A hard model in general is a mathematical function which is derived from equations representing the physics behind an underlying process. In PEAXACT, the
term hard model refers to a function derived from the physics of molecular spectroscopy; it is a mathematical representation of a mixture spectrum.
Physics tells us that a mixture spectrum is composed of superimposed peaks originating from the individual components in the mixture, with the components' concentrations being responsible for the peaks' intensities. This structural information is maintained in the hard model by means of a sum of peak-shaped curves.
Those subsets of peak-curves that represent pure component spectra are referred
to as component models; they are multiplied by concentration-related weight parameters.
In summary, the hard model consists of weighted component models which again
consist of peak models. The hard model is completed by a simple baseline model.
Component Model
The component model is a mathematical representation of a pure component
spectrum. It consists of peak models.
Peak Model
The peak model is a mathematical function with a peak-shaped profile. PEAXACT
uses pseudo-Voigt functions. A pseudo-Voigt function is a linear combination of
Gaussian and Lorentzian functions.
Baseline Model
The baseline model is a linear or quadratic polynomial.
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Component Weight
The component weight is a parameter of the hard model. The hard model is a
weighted sum of component models, i.e. each component model is multiplied
with its component weight. Component weights correspond to concentrations;
they are relevant parameters for calibration.
Peak Parameters
Peak parameters are the parameters of peak models, e.g. the position or width.
These parameters are adjusted when fitting the hard model to measured samples
in order to correct peak variations.
Editable Component & Editable Peaks
The first component model of the hard model is called "editable component" because peak models can only be added, removed, or modified in this component.
Accordingly, peaks of the editable component are called "editable peaks".
Model Fitting, Peak Fitting & Component Fitting
Model fitting is a general expression for a mathematical procedure in which the
model’s parameters are automatically adjusted until the model fits a certain measured sample. Peak fitting and component fitting are special kinds of model fitting
which differ in the parameters being adjusted. Peak fitting refers to the adjustment of peak parameters of only the editable peaks. Component fitting mainly
refers to the adjustment of component weights. Errors in component weights can
be reduced by simultaneously adjusting peak parameters to account for peak variations in the measured sample. The extent of peak adjustments during component fitting is controlled by model settings.

3.8.5.1

New Hard Model

Menu bar:
Context menu:

Edit Model > Hard Model > New…
Model Tree > Hard Model Item > New

A new dialog appears in order to specify the name of the first component model. The first
component of each hard model called editable component because new peak models can
only be added, removed, and modified for this component.
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Name of Editable Component
If it is your intention to add peaks to the editable component, you should name it after the
pure component to be modeled. If, however, you do not want to add peaks because you only
intend to import other component models, you should name the editable component like
"empty" or "-". You can always rename components later.
If a data set is active while the new hard model is being created, the name of the editable
component is suggested to be the data set name.

New Hard Model for Active Sample
Context menu:

Data Sets Panel > New Hard Model for Active Sample

When creating a hard model from the context menu of the Data Sets Panel the first component is automatically named after the active data set. If the currently active master model
already has a hard model, or if no master model is active at all, a new master model is created
first.

New Hard Model if Required
Some hard modeling actions automatically prompt you to create a new hard model if none
exists.

3.8.5.2

Remove Hard Model

Menu bar:
Context menu:

Edit Model > Hard Model > Remove
Model Tree > Hard Model Item > Remove

When removing a hard model, all its dependent models will be removed, too, namely the
baseline model, component models, and also components fits of the hard model to data sets.
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Add & Auto-fit Peaks

Toolbar:
Menu bar:
Context menu:
Context menu:

Edit Model > Hard Model > Add & Autofit Peaks…
Model Tree > Hard Model Item > Add & Autofit Peaks…
Model Tree > First Component Item > Add & Autofit Peaks…

Auto-fitting of peaks is a combination of adding new peaks to the editable component and
automatically adjusting editable peaks such that the model fits the active sample.
You are prompted to enter the number of new peaks. Start with a rough count of peaks in the
sample and add more peaks later if required.

Note: New peaks will always be added to the editable component.
The peak fitting algorithm is controlled by model settings. In general, first the position of the
next peak to be added is determined by analyzing the spectral residuals, then a new peak
model is added to the editable component, and finally the model is fitted to the active sample
according to the peak fitting procedure.

3.8.5.4

Remove Selected Peaks

Menu bar:
Context menu:
Context menu:

Edit Model > Hard Model > Remove Selected Peaks
Model Tree > Peak Model Item > Remove
Plot Panel > Peak Plot > Remove

From the menu bar and from the context menu of the Model Tree Panel you can remove the
selected peak. You can also select a peak in the Model Tree Panel or its graphical representing
in the Plot Panel and press the delete key.

3.8.5.5

New Component from Selected Peaks

Menu bar:
Context menu:
Context menu:

Edit Model > Hard Model > New Component from Peaks…
Model Tree > Peak Model Item > New Component…
Plot Panel > Peak Plot > New Component…
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Selected peaks of the editable component can be moved to a new component. You are
prompted to enter the new component’s name.

3.8.5.6

Import Components

Toolbar:
Menu bar:
Context menu:
Drag & Drop:

Edit Model > Hard Model > Import Components…
Model Tree > Hard Model Item > Import Components…
from Explorer to Model Tree Panel

The File Dialog can be used to browse directories and select one or more model files to import
component models from. Choose a file filter from the pull-down list to localize certain model
files. A master model must be active in order to import components.
All non-empty components of the source models are copied to the active model. If no hard
model exists yet, you will be prompted to create one first.
Names of imported components that already exist will automatically be numbered consecutively.

Drag and Drop
A fast way to import component models is by using drag & drop. Activate the target model
in the Model Tree Panel, then drag model files from the Windows Explorer (e.g.) and drop
them into the Model Tree Panel. You will be asked whether to open these files or to import
components into the active model.
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Component Equilibration
Imported component models are equilibrated, which means that
•
•

component weights are set to 1, and
peak amplitudes of each component are scaled such that the maximum peak amplitude is in the same order of magnitude as the active sample (or 1 if no sample is active)

Component equilibration is reasonable because otherwise parameters of different component models could have totally different orders of magnitude.
Caution: Do not import components while a sample is active which is completely
unrelated to the hard model.

3.8.5.7

Rename Components

Menu bar:
Edit Model > Hard Model > Rename Component…
Context menu: Model Tree > Component Model Item > Rename
Properties Panel: Click Model Tree > Hard Model Item
From the menu bar or the context menu of the Model Tree Panel you can rename the active
component. In addition, when activating the Hard Model item in the Model Tree Panel, you
can rename components in the Properties Panel.
Component models can get any names as long as they are unique within each hard model.

3.8.5.8

Remove Components

Menu bar:
Context menu:

Edit Model > Hard Model > Remove Component
Model Tree > Component Model Item > Remove

From the menu bar and from the context menu of the Model Tree Panel you can remove the
active component model. You can also select a component model item in the Model Tree
Panel or its graphical representing in the Plot Panel and press the delete key.
Note: You cannot remove the editable component.

3.8.5.9

Export Components

Menu bar:
Context menu:

Edit Model > Hard Model > Export Component
Model Tree > Component Model Item > Export…

Each component model can be exported to a new model file. The new master model will contain a hard model with just the one component model. In addition, the data pretreatment
model is copied to the new model, too. The File Dialog can be used to browse directories and
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select or enter a filename for the model to be saved. By default, the component name is suggested as filename.
Exporting of components is not required if the hard model only contains a single component.
In that case, simply save the master model.

Overwriting Existing Files
As a precaution, you cannot save the model to a file of another model that is currently opened
in PEAXACT. You have to close the other model before overwriting its file.

3.8.5.10

Adjust Parameters Manually

Manual modification of hard model parameters becomes reasonable when automatic parameter adjustment does not work as expected. Then, minor manual modifications could remedy
these modeling problems. However, manual adjustments should always be followed by automatic parameter fitting in order to further improve the model.

Changing Parameter Values
The following parameter values can be modified manually using the Model Tree Panel:
•
•

all baseline parameters
peak parameters of the editable component

The following parameters cannot be modified manually:
•
•

component parameters (component shift and component weight)
peak parameters of other components than the editable component

Select the hard model item in the Model Tree Panel or its graphical representation in the Plot
Panel in order to display the element's parameters in the Properties Panel. Use the table in
the Properties Panel to change parameter values.

Fixing Parameters
All model parameters but component weights can be fixed, which means that parameter values are not allowed to get changed during model fitting. Still, parameters are allowed to get
changed manually.
Select the model item in the Model Tree Panel or its graphical representation in the Plot Panel
in order to display the element's parameters in the Properties Panel. Use the check boxes in
the Properties Panel to fix or free parameter values. Baseline parameters and peak parameters can also be fixed all at once from the element's context menu.
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Important note: The position of peak models is influenced by two parameters, the
peak position parameter and the component shift parameter. While the former is
individual for each peak, the latter is the same for all peaks of a component. Fix
both parameters if you do not want peak models to get shifted.
Fixing parameters is useful for reducing model complexity (because less parameters have to
be adjusted during model fitting), but at the same time model flexibility is reduced, too, because less peak variations in the sample can be explained by the model.

Adding Peaks
Context menu:

Plot Panel > Add Peak

To add a peak model manually, right-click at the desired peak position in the Plot Panel and
select Add Peak from the context menu. The new peak model has its position and maximum
at the clicked point and gets some suggested values for the other peak parameters.
Note: New peaks will always be added to the editable component.

Removing Peaks
Menu bar:
Context menu:
Context menu:

Edit Model > Hard Model > Remove Selected Peaks
Model Tree > Peak Model Item > Remove Selected Peaks
Plot Panel > Peak Plot > Remove Selected Peaks

You can remove currently selected peak models from the hard model. Select a peak model
item in the Model Tree Panel or its graphical representing in the Plot Panel first. In the Plot
Panel you could even select multiple peaks while the SHIFT-key is pressed.
Only peaks of the editable component can be removed.

Modifying Peaks Interactively
Peaks models can be modified interactively by using the mouse:
•
•

Height and position: Grab the top of an editable peak plot and move the mouse up /
down to change the height and move it to the right / left to change the position
Width: Grab one side of an editable peak plot and move the mouse to the right / left

Solutions for Process Analytics & Control Technology

3 - PEAXACT USER INTERFACE

81

Caution: You should always respect specified constraints for the peak width parameter when modifying peaks manually. Otherwise, model fitting might not work
as expected or might not work at all.

Grouping Peaks
Context menu:

Plot Panel > Peak Plot > Peak Grouping > Group / Ungroup

Grouped peaks behave like a single new peak with new shape. Select two or more peak plots
in the Plot Panel (left-click on the plots while the SHIFT-key is pressed) and then right-click
on one of the plots to open the context menu. From the context menu you could either add
all selected peaks to a new group or release peaks from the group. When clicking on a
grouped peak in the Plot Panel, the whole group is selected. When clicking on a grouped peak
in the Model Tree Panel, only the clicked peak is selected.
Because of the following impacts, peak grouping is relevant for component fitting only:
•
•

The intensity of grouped peaks (peak area) is kept constant as a sum, but not for each
peak individually (see also: Fitting Options).
If a parameter (e.g. position) of any peak is considered for automatic adjustment, the
same kind of parameter of all peaks in the group will be fitted, too.

Peak grouping is particularly useful to model asymmetric measured peaks by multiple symmetric peak models.
Caution: Peak grouping should only be used for fine tuning the model.

Switching Baseline Polynomial between Linear and Quadratic
Menu bar:
Context menu:
Context menu:

Edit Model > Settings… > Hard Model > Baseline order
Model Tree > Baseline Model Item > Quadratic Baseline
Plot Panel > Baseline Plot > Quadratic Baseline

The baseline model can be a linear or quadratic polynomial. The linear baseline has two parameters (offset and slope), the quadratic baseline has three parameters (offset, slope, and
quadratic factor).
The baseline model should be choses as simple as possible because it is partly redundant to
baseline corrections specified in the data pretreatment model.
Caution: Consider switching to "quadratic" as a last resort. Try to work around the
issue by choosing different data pretreatments such as range selection and baseline correction.
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Modifying Baseline Interactively
If the baseline model is displayed as a separate plot in the Plot Panel (see preferences), it can
be modified interactively by using the mouse. In case of a linear baseline model:
•
•

Offset: Grab the center of the baseline plot and move the mouse up / down
Slope: Grab the left or right fifth of the baseline plot and move the mouse up / down

In case of a quadratic baseline model, baseline parameters are determined by means of three
points the baseline goes through. You can adjust the baseline parameters by moving these
three points:
•
•

Center point: Grab the center of the baseline plot and move the mouse in any direction
Leftmost point, rightmost point: Grab the left or right fifth of the baseline plot and
move the mouse up / down

3.8.5.11
Toolbar:
Menu bar:
Toolbar:
Menu bar:

Adjust Parameters Automatically
Edit Model > Hard Model > Adjust Editable Peaks
Edit Model > Hard Model > Adjust Components > …

The model's parameter can be adjusted automatically such that the model fits a certain
measured spectrum. Model fitting is an important step because the hard model is intended
to represent a mixture spectrum well. A good fit will provide good initial parameter values for
subsequent analyses.
There are two kinds of model fitting: peak fitting and component fitting. They differ in parameter constraints being applied and in the set of parameters being adjusted.

Peak Fitting
Peak fitting is suited for creating new hard models from the scratch. Basically, it is an unconstrained fit (except for bounds on peak width and shape parameters) of editable peaks and
therefore it is qualified for making major parameter adjustments, e.g. when adding or removing peaks.
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In detail, peak fitting covers:
•
•
•

adjustment of all parameters of all editable peaks
adjustment of baseline parameters
adjustment of component weights

Component Fitting
Component fitting is suited for fine tuning parameters of an existing hard model. Basically, it
is a fit of component weights but other parameters can be adjusted, too, according to the
chosen parameter set. These additional parameters are fitted with respect to tight constraints. In particular, peak parameters can only vary with respect to constant peak intensities
(peak areas). Because of these constraints, component fitting is only qualified for moderate
parameter adjustments.
Note: Component fitting is also performed during some analyses, but while the
analysis never changes the hard model, during modeling the hard model is actually
changed in that adjusted parameter values become new initial values.
Adjusting model parameters by means of component fitting is often not necessary, though
in some cases it can be reasonable to get better initial parameter values.

Repeated Model Fitting
When conducting peak fitting or component fitting repeatedly it is likely you will see the fit
improving slightly each time. There are several reasons for this, e.g.:
•
•

Stopping criteria for model fitting are measured relative to the starting point. The
starting point of each new fit is the previous fit.
Relative parameter bounds might be reached during one fit. Each new fit has new
bounds.
Caution: Repeated component fitting might significantly deform peaks. This could
even result in poorer initial parameter values.

3.8.5.12

Settings for Hard Model Fitting

Hard model fitting is affected by several settings.

Modification
Properties Panel: Click Model Tree > Hard Model Item > Left-click toggle button
Hard model settings can be modified by using the Model Properties Panel. Select the Hard
Model item or any of its sub-items in the Model Tree Panel and then left-click the toggle button in the Model Properties Panel. The buttons toggles between hard model parameters and
hard model settings. For a description of all available settings see Section 3.2.7.
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1

(1) Toggle between hard model parameters view and hard model settings view

Reset
Context menu:

Click Model Tree > Hard Model Item > Right-click toggle button

Hard model settings can be reset to preferences defined in the active session profile. Rightclick the toggle button and choose Reset from the context menu.

3.8.6

Calibration Model

The Calibration Model is a sub-model of the master model. It is a functional relationship between values calculated from samples (e.g. component weights) and predictive features (e.g.
concentrations). The functional relationship is established by regression.

3.8.6.1

New Calibration Model

Toolbar
Menu bar:
Context menu:

Edit Model > Calibration Model > Calibrate…
Model Tree > Calibration Model Item > Calibrate…

Calibration is performed for selected data sets. All selected data sets must provide a common
set of predictive features. Data sets with usage set to "train" or "unspecified" will be used for
training the calibration model. Data sets with usage set to "test" will be used for validating
the calibration model. Data sets with usage set to "ignore" will not be considered.
Calibration begins with the specification of settings. Results are then displayed in a Report
Window. Finally, you have to choose and accept a specific calibration model.
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Calibration Setup

Calibration Settings Dialog for univariate (left) and multivariate calibration (right)
The Calibration Settings Dialog contains four panes for the decisions you have to make:
1)
2)
3)
4)

Which calibration method should be used?
Which features should be calibrated?
Which settings should be used for regression of the calibration model?
Which settings should be used for validation of the calibration model?

Calibration Method
You can choose between three different calibration methods. Depending on your choice, the
Calibration Settings Dialog changes its appearance to provide proper controls for each
method.
•
•
•

Peak Integration (PI) Regression: available if the master model contains an integration
model
Hard Modeling (HM) Regression: available if the master model contains a hard model
Partial Least Squares (PLS) Regression: always available

Feature Selection
The table shows a list of available predictive features. Use the checkboxes to activate/deactivate features for calibration.
•
•

For PI, each active feature must be linked with an integration range in order to provide
a connection between features and peak areas.
For HM, each active feature must be linked with a hard model component in order to
provide a connection between features and component weights.
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Regression Settings
First select the kind of regression variables:
•

•

For PI and HM, regression variables can be “normal” or “ratios”.
• normal: always available; regression of the calibration model is performed separately for each feature
• ratios: available if the sum of active feature values is the same constant (closure
constraint) for each data set; regression of the calibration model is done for pairwise ratios of features and by incorporating a closure constant.
For PLS, regression of the calibration model is always performed separately for each
feature. Regression variables can be “centered” or “centered + scaled”.
• centered: the mean of all training samples is subtracted from each sample, creating a set of difference spectra
• centered + scaled: spectra are also normalized by the standard deviation of all
training spectra

Then, choose the maximum polynomial degree of the regression function (HM and PI) or the
maximum rank (PLS). A separate model will be calibrated for each function / rank up to the
selected maximum.
•

•

Regression function: the regression function is used by univariate calibration methods
(PI, HM) to establish the functional relationship between component peak areas /
weights and predictive features. A special function "simple" can be chosen; it is a linear
function without intercept.
Rank: the rank is used by multivariate calibration methods (PLS). It is the number of
multivariate factors used to explain the variance of the data.

If the "Location" feature is provided for data sets, you can optionally enable "Individual regression for each measurement location". In this case, a separate model will be calibrated for
each location.
Validation settings
Validation is a sub-step of calibration to validate the predictive quality of a model. In general,
the kind of validation that can be performed depends on the provided data. PEAXACT will
always calculate the root mean squared error of calibration (RMSEC) from the training samples. If independent test samples are provided, the root mean squared error of prediction
(RMSEP) is calculated as well. Cross-validation is performed according to the options you
choose during the calibration setup.
First select the kind of partitioning you want to use for cross-validation:
•
•

none: Cross-validation is disabled (not recommended).
Leave-1-out: One sample is used as the validation set while all others are used for
training. A new calibration is performed with the training set and the left-out sample
is predicted. After repeating this for all samples, a mean prediction error is calculated:
the root mean squared error of cross-validation (RMSECV).
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Leave-%-out: The training samples are divided into subsets containing several samples, according to the %-value. One subset is left out form the set of independent validation samples while all other samples are used for calibration. This is repeated until
all subsets have been left out once and a mean prediction error is calculated.
Leave-1 group-out: Subsets are formed according to the grouping feature. All samples
that have the same grouping feature value will form a subset and will be left out together.

If using Leave-%-out, choose the percentage of your samples to leave out in each subset during cross-validation. You can optionally choose a categorical feature for stratification. Stratified cross-validation creates subsets which roughly have the same composition of the categorical feature as the whole set of samples.
If using Leave-1 group-out you need to choose a categorical feature for grouping.
Finally, start calibration by clicking the OK button.

Calibration Results

Calibration Report Window
Results are displayed in a Report Window. Different results may be available depending on
the calibration method.
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Available Reports
Predicted vs. True
Predicted feature values 𝑥𝑝𝑟𝑒𝑑𝑖𝑐𝑡𝑒𝑑 are plotted against the actual values 𝑥𝑡𝑟𝑢𝑒 for each sample. Samples are color-coded by their usage (green = training samples, blue = test samples).
The plot can be used determine the predictive accuracy of the model and to spot feature outliers.
𝑥𝑝𝑟𝑒𝑑𝑖𝑐𝑡𝑒𝑑 is calculated from samples 𝑌 using the calibration model 𝑓(𝑌, 𝐾).
𝑥𝑝𝑟𝑒𝑑𝑖𝑐𝑡𝑒𝑑 = 𝑓(𝑌, 𝐾)
The structure of function 𝑓(𝑌, 𝐾) depends on the calibration method (PI, HM, PLS) and on
the regression settings.
A best-fit line though the training points – the recovery function – is added to the chart.
𝑥𝑟𝑒𝑐𝑜𝑣𝑒𝑟𝑒𝑑 = 𝑖𝑛𝑡𝑒𝑟𝑐𝑒𝑝𝑡 + 𝑠𝑙𝑜𝑝𝑒 ∙ 𝑥𝑡𝑟𝑢𝑒
In case of a perfect calibration, intercept and slope of the recovery function would be zero
and one, respectively, i.e. it would match the identity line. The deviation from the identity
line can be used as an indicator for the predictive capability of the calibration model.
Differences vs. True
Differences between predicted and actual values are plotted for each sample.
𝑥𝑑𝑖𝑓𝑓𝑒𝑟𝑒𝑛𝑐𝑒 = 𝑥𝑝𝑟𝑒𝑑𝑖𝑐𝑡𝑒𝑑 − 𝑥𝑡𝑟𝑢𝑒
Typically, differences will be distributed around zero. The plot can be used to determine shifts
and drifts in the calibration by analyzing the distribution pattern.
A dashed line – the average bias – is added to the chart. The average bias is the mean of the
differences.
𝑁

1
𝑏𝑖𝑎𝑠 = ∑ 𝑥𝑑𝑖𝑓𝑓𝑒𝑟𝑒𝑛𝑐𝑒,𝑖
𝑁
𝑖

The average bias is shown for training samples (bias C, green) and test samples (bias P, blue).
It can be interpreted as the systematic error of prediction, i.e. predictions are off by this value
on average.
Predicted vs. ...
Predicted feature values are plotted against a selectable feature.
R² vs. Function / Rank
R² is the fraction of variance in 𝑥 which is explained by the calibration model. A value of 1
corresponds to 100%. The plot gives an overview of R² for different regression functions /
ranks.
𝑁
2

𝑅 =1−∑

(𝑥𝑝𝑟𝑒𝑑𝑖𝑐𝑡𝑒𝑑,𝑖 − 𝑥𝑡𝑟𝑢𝑒,𝑖 )

(𝑥𝑡𝑟𝑢𝑒,𝑖 − 𝑥̅𝑡𝑟𝑢𝑒 )
𝑥: feature values (e.g. concentrations) of training samples.
𝑥̅𝑡𝑟𝑢𝑒 : mean 𝑥𝑡𝑟𝑢𝑒 of all training samples.
𝑁: number of training samples.

2

2

𝑖
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R² could be negative if the calibration model predicts features worse than a constant function
would do. Obviously, such models should be discarded.
RMSE vs. Function / Rank
RMSEC is the Root Mean Square Error of Calibration. It is the average deviation between predicted and actual feature values of the training samples.
𝑁

1
2
𝑅𝑀𝑆𝐸𝐶 = √ ∑(𝑥𝑝𝑟𝑒𝑑𝑖𝑐𝑡𝑒𝑑,𝑖 − 𝑥𝑡𝑟𝑢𝑒,𝑖 )
𝑁
𝑖

RMSECV is the Root Mean Square Error of Cross-Validation. It is the average deviation between predicted and actual feature values when doing a cross-validation of training samples.
Use this report to determine the regression function / rank with the least error if no independent test samples are available.
𝑛

1
2
𝑅𝑀𝑆𝐸𝐶𝑉 = √ ∑(𝑥𝑝𝑟𝑒𝑑𝑖𝑐𝑡𝑒𝑑 𝐶𝑉,𝑖 − 𝑥𝑡𝑟𝑢𝑒,𝑖 )
𝑁
𝑖

𝑥𝑝𝑟𝑒𝑑𝑖𝑐𝑡𝑒𝑑 𝐶𝑉,𝑖 : calculated internally and not displayed in any report.
RMSEP is the Root Mean Square Error of Prediction. It is the average deviation between predicted and actual feature when doing a test-set validation of independent test samples. Use
this report to determine the regression function / rank with the least error.
𝑁′

1
2
′
′
𝑅𝑀𝑆𝐸𝑃 = √ ′ ∑(𝑥𝑝𝑟𝑒𝑑𝑖𝑐𝑡𝑒𝑑,𝑖
− 𝑥𝑡𝑟𝑢𝑒,𝑖
)
𝑁
𝑖

′

𝑥 : feature values of independent test samples.
𝑁 ′ : number of test samples.
RMS Spectral Residuals vs. True
RMS Spectral Residuals vs. ...
The Root Mean Squared Spectral Residuals measure how well the model explains the spectral
data. It can be used to spot spectral outliers. The smaller the value the better the model explains the spectral signal.
𝑃

1
2
𝑅𝑀𝑆 𝑅𝑒𝑠 = √ ∑(𝑦𝑟𝑒𝑐𝑜𝑛𝑠𝑡𝑟𝑢𝑐𝑡𝑒𝑑,𝑖 − 𝑦𝑚𝑒𝑎𝑠𝑢𝑟𝑒𝑑,𝑖 )
𝑃
𝑖

𝑦: spectral intensities.
𝑦𝑟𝑒𝑐𝑜𝑛𝑠𝑡𝑟𝑢𝑐𝑡𝑒𝑑 : spectral intensities reconstructed by the model. For HM this is the fitted hard
model; for PLS it is the reconstruction using 𝑅 PLS loadings. Spectral residuals are not available for PI models.
𝑃: number of spectral data points.
𝑅: rank of the PLS model.
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Mahalanobis distance vs. True
Mahalanobis distance vs. RMS Spectral Residuals
Mahalanobis distance vs. ...
The Mahalanobis Distance tells how similar a sample is to the set of training samples and can
be used to spot spectral outliers. It is a measure of the multivariate distance from the centroid
comprised of the PLS scores of all training samples. The Mahalanobis distance is not available
for HM and PI models.
𝑀𝐷𝑖 = √𝑠𝑖 ∙ (𝑆 𝑇 ∙ 𝑆)−1 ∙ 𝑠𝑖𝑇 ∙ (𝑅 − 1)
𝑠𝑖 : row vector of 𝑅 PLS scores of sample 𝑖 for which the MD should be calculated.
𝑆: is the 𝑁-by-𝑅 matrix of row-wise PLS scores of all training samples.
𝑅: PLS rank.
𝑁: number of training samples.
Superscript 𝑇 denotes the transposed matrix.
Superscript −1 denotes the inverse matrix.
Calibration curve
The calibration curve is the actual regression function of the calibration model. It can only be
displayed for univariate calibration (HM and PI).
𝑥𝑖 = 𝑌𝑖 ∙ 𝐾
𝑥: features of training samples.
𝑌𝑖 : design matrix of component weights (HM) or peak areas (PI) of sample 𝑖.
𝐾: vector of regression coefficients (calibration constants).
Note that the regression function is linear in 𝐾, but could be nonlinear in component weights
or peak areas depending on how the design matrix is built. For instance:
𝑥𝑖 = [𝜔𝑖0 𝜔1𝑖 𝜔𝑖2 ] ∙ [𝑘0 𝑘1 𝑘2 ]𝑇
would be quadratic in component weights 𝜔.
PEAXACT uses inverse calibration (regression of 𝑥 on 𝑌) to calculate K. It has been shown that
inverse calibration yields more precise predictions of unknowns than classical calibration [Tellinghuisen2000].
PLS Loadings
PLS loadings are the actual regression data from the PLS algorithm, and they allow you to
examine how PLS "sees" the data; that is, how it is modeling the samples. PLS loadings take
the form of spectra because the x-axis is the same as of the training samples. Typically, at
higher ranks, loadings look more and more noisy. As the rank increases, more of the noise in
the system is being modeled. Use this report to determine the maximum rank which does not
model noise.
𝑦𝑟𝑒𝑐𝑜𝑛𝑠𝑡𝑟𝑢𝑐𝑡𝑒𝑑,𝑖 = 𝑠𝑖 ∙ 𝐿𝑇
𝑦𝑟𝑒𝑐𝑜𝑛𝑠𝑡𝑟𝑢𝑐𝑡𝑒𝑑,𝑖 : reconstruction of spectrum 𝑖.
𝑠𝑖 : row vector of 𝑅 PLS scores of spectrum 𝑖.
𝐿: 𝑃-by-𝑅 matrix of column-wise loadings. Loadings are calculated from training samples using the SIMPLS algorithm.
𝑅: rank of the PLS model.
𝑃: number of data points.
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Report Customization

1

2

3

4

X-Axis
For several reports, you can change the x-axis to any provided data set feature (1). See Section Data Table Editor for how to add features to data sets.
Feature Selection
Use the pull-down menu (2) to display results for individual calibrated features.
Function / Rank
Use the pull-down menu (3) to display results for individual regression functions / ranks.
Location
Use the pull-down menu (4) to display results for individual locations.

Accepting a Specific Calibration
In order to finalize calibration, you have to decide on a specific regression function / rank for
each calibrated feature. Make your choice in the bottom-left pane of the Report Window.

By clicking the OK button of the Report Window, your choice is accepted and the calibration
model is stored in the master model. Furthermore, because calibration marks the final step
of modeling, you are prompted to export the model summary report to your hard disk.

3.8.6.2

Remove Calibration Model

Menu bar:
Context menu:

Edit Model > Calibration Model > Remove
Model Tree > Calibration Model Item > Remove
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Removing the calibration model will remove all calibrated features. Please note that you cannot independently remove single calibrated features.

3.8.6.3

View

Menu bar:
Context menu:

Edit Model > Calibration Model > View
Model Tree > Calibration Item > View

You can view the results of current calibration again in the Calibration Report Window, where
all standard reports are available.
Since the calibration report is opened in “View Mode”, options that would change the calibration model are disabled.

3.8.6.4

Rename Calibrated Feature

Context menu: Model Tree > Calibrated Feature Item > Rename
Properties Panel: Click Model Tree > Calibration Model Item
Note: This operation applies to after a calibration model has been created. If you would like
to change feature names prior to calibration, use the Data Table Editor.
From the context menu of the Model Tree Panel you can rename the selected calibrated feature. In addition, when activating the Calibration Model item in the Model Tree Panel, you
can rename features in the Properties Panel.
A calibrated feature can have any name as long as it is unique within the calibration model.

3.9

Analysis

Analysis of data is a process of data transformation by inspecting and modeling data with the
goal of highlighting useful information.
PEAXACT covers two kinds of analysis steps: data-driven analysis and model-based analysis. Data-driven analysis comprises visual data inspection and plausibility tests of data.
Model-based analysis refers to the conversion of measured data to quantities of interest by
means of a mathematical model. Model-based analysis has multiple facets depending on individual analysis methods.
Data-driven analysis can be performed with the Data Inspector. This Section is dedicated to
the specifics of model-based analysis.
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Typical Analysis Workflow

Select Data Sets

Choose
Analysis Method

Make Settings
(some analyses)
Wait while
Analysis is
Performed

(1) In the Data Sets Panel select data sets you want to analyze. Data sets tagged as “ignore” will be ignored.
(2) Choose an analysis method from the Analysis menu.
Method availability depends on the active model. E.g. in
order to perform a prediction, the model must be calibrated. Some analyses don’t require a model but may
work better / differently if one is provided.
(3) Some analyses need additional input.
(4) Processing time depends on the chosen analysis
method, on the number of selected data sets, and on the
performance of your computer.
(5) Results are displayed in a Report Window.

Generate
Reports from
Results

See Chapter 4 for full workflow diagrams of individual analyses.

3.9.2

Peak Picking

Menu bar:

Analysis > Peak Picking

Peak picking is applied to selected data sets. A model is not required for this analysis, but if
one is active, data pretreatments are applied.
Peak picking analysis finds local maxima in the signal and displays corresponding x- and y-values. Results are displayed in a Report Window.
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2
1
3

Peak Picking Report Window

Available Reports
Peaks
Positions of peaks plotted (in red) into chart of selected sample (black)
Report Table
Table with numeric values of peak positions and peak intensities

Report Customization
Peak Detection Limit
Move the slider (1) up and down to increase and decrease the detection limit of peaks.
Sample Selection
The report shows results for a single sample at a time. Select the visible sample from the pulldown menu (2).
Peak Selection
By default, all detected peaks are shown in the graphical and tabular report. Use the list (3) to
select and show specific peaks only.
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Edit Peak Label
Left-click on the red peak label to start editing. Note that labels will be reset each time you
change the peak detection limit, the sample, or the peak selection.

3.9.3

MCR-ALS

Menu bar:
Menu bar:

Analysis > MCR-ALS > Component Number Analysis
Analysis > MCR-ALS > Component Analysis

Multivariate Curve Resolution (MCR) Alternating Least Squares (ALS) is applied to selected
data sets. A model is not required for this analysis, but if one is active, data pretreatments are
applied.
Multivariate Curve Resolution designs a group of techniques which intend the recovery of the
pure response profiles (spectra, pH profiles, time profiles, elution profiles ...) of the chemical
constituents or species of an unresolved mixture when no prior information is available about
the nature and composition of these mixtures.

The Bilinear Model of MCR
MCR requires the experimental data to be explained reasonably well by a bilinear model using
a limited number of components. The MCR bilinear model is usually written down as 𝐷 =
𝐶𝑆 𝑇 , where 𝐷 is the spectroscopic data matrix, and 𝑆 𝑇 and 𝐶 are the matrices of the pure
spectra and the related concentration profiles for each of the compounds (contributions) in
the system. 𝐶 and 𝑆 𝑇 are the small matrices of the bilinear model that contain profiles of the
pure contributions (species, compounds) of the original data matrix and may change chemical meaning depending on the nature of the data
MCR-ALS is an algorithm that solves the MCR basic bilinear model using a constrained Alternating Least Squares algorithm. The constraints used to improve the interpretability of the
profiles in 𝐶 and 𝑆 𝑇 may respond to chemical properties of these profiles (e.g., non-negativity, unimodality, closure ...) or have a mathematical origin (e.g., local rank and selective windows, trilinear structure ...). The ‘art’ and expertise in using MCR-ALS stems from the proper
selection and application of the constraints that are really fulfilled by the data.

3.9.3.1
Menu bar:

Component Number Analysis
Analysis > MCR-ALS > Component Number Analysis
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Component Number Analysis consists in the estimation of the number of unknown mixture
constituents. Results are displayed in a Report Window.

Available Reports
Eigenvalues of Principal Components
The eigenvalues of principal components indicate how much each principal component contributes to explaining the variance of the data matrix. The most likely number of components
is reached when the next eigenvalue is small, i.e. when the next principal component does
not significantly increase the explained variance any more. Note that the diagram only displays major principal components which explain up to 99.9% of the variance.
Ratios
The ratios plot supplements the Eigenvalues-plot by showing the ratios of two successive eigenvalues. The most likely number of components is indicated by a large ratio.
Factor Indicator Function
The factor indicator function reaches a minimum where the correct number of factors/components is expected. However, this only occurs when the error is random and fairly uniform
throughout the entire data. [E. R. Malinowski, Analytical Chemistry, Vol. 49 (4), April 1977].
In real cases, the function is typically L-shaped for about the first 10 components and the most
likely number of components is indicated by a more or less sharp bend in the curve.

3.9.3.2

Component Analysis

Menu bar:

Analysis > MCR-ALS > Component Analysis

Component Analysis consists in the identification of unknown component spectra and the
computation of concentrations for each component. Results are displayed in a Report Window. Additional input is required for this analysis:
3

1
2

3
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The number of components to be identified must be specified (1) and optional additional constraints (2) to improve the outcome of the analysis:
Non-negative spectra
Enable this constraint if y-values of pure component spectra are positive. This is
usually valid for spectroscopic and chromatographic data. However, it does not
hold if you use a pretreatment model with derivatives.
Non-negative concentrations
Enable this constraint if concentration values are positive. This is usually valid for
molar or weight concentrations/fractions.
Concentration profiles with single maximum (unimodal)
Enable this unimodality constraint if the shape of concentration profile has a single maximum. This also applies to profiles which are monotonously increasing or
decreasing.
Sum of concentrations = 1 (closure)
Enable this closure constraint if component concentrations sum up to 1.
Use known concentrations (N components)
Enable this constraint to use feature values as known concentrations. Feature values could be provided for all or just some data sets. Any available information will
be exploited by MCR. See Section Data Table Editor for how to add features to
data sets.
MCR-ALS is an iterative algorithm which uses convergence options (3) as stopping criteria:
Display intermediate results
Enable this checkbox to display graphical progress of component spectra and concentration profiles after each iteration.
Maximum number of iterations
Algorithm stops after a specified number of iterations
Maximum number of unsuccessful
Algorithm stops after a specified number of iterations without progress
Convergence tolerance
Algorithm stops after a specified accuracy is reached

Available Reports
Component Spectra
Spectra of identified pure components
Concentrations
Estimated concentrations (dimensionless)
RMS Spectral Residuals
Euclidean mean error of identified component spectra fitted linearly to measured samples
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Table: Concentration Profiles
Numeric values of computed concentrations
Table: Component Spectra
Numeric values of pure component spectra

Report Customization
X-axis
By default, concentrations and RMSE values are plotted against the sample index. You can
change the x-axis to any available data set feature. See Section Data Table Editor for how to
add features to data sets.
Component Selection
By default, plots of all pure component spectra and concentrations are shown in the graphical
report. Use the list for selective plotting. Note that RMSE values are independent of the selected component.

More Iterations
You could carry out more iterations in order to improve results. When clicking More Iterations at the bottom of the Report Window, MCR-ALS starts at again, letting you choose different constraints if desired, but using previous results as starting values.

3.9.4

HMFA

Menu bar:
Menu bar:

Analysis > HMFA > Component Number Analysis
Analysis > HMFA > Component Analysis

Hard Modeling Factor Analysis (HMFA) is applied to selected data sets. A hard model is required for this analysis.
HMFA is a technique which intends the recovery of pure component spectra and concentration profiles of the chemical constituents of a mixture when no prior information is available
about the nature and composition of these mixtures. It is akin to other factor analysis methods, e.g. Multivariate Curve Resolution (MCR), but results are closer to physics due to the usage of hard models.

The Hard Model of HMFA
The hard model in HMFA is used to provide the factor analysis with as much information as
possible about the spectral structure of the mixture. E.g., if any pure component spectrum is
known in advance, a corresponding component model should be part of the hard model. All
remaining peaks belonging to unknown components should be modeled in the first hard
model's component. HMFA will decompose peaks of the first component model into new
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component models by analyzing the mixture spectra and identifying peaks that belong together.
If, for instance, all pure component spectra were unknown, you could initially create a hard
model with all peaks contained in the first component model and let HMFA reassign them to
new component models.
The identification of unknown component spectra works well if two requirements are met:
•

•

The first component model must contain all the relevant peaks. No peaks must be
missing, because only existing peaks can be reassigned. For creating such a representative model, it is recommended to use a representative sample of the mixture
spectra for modeling.
The mixture spectra must contain reasonable variation in the components' concentrations.

Eventually, HMFA fits the new hard model (which now contains all identified component
models and all initially provided component models) to the mixture spectra in order to compute component weights. Please note that this kind of component fitting differs from regular
Component Fitting Analysis in the following aspects:
•
•
•

The hard model is fitted linearly no matter the component fitting mode specified in
the model settings.
Fixed parameters are adjusted anyway.
The baseline model is ignored; instead a linear baseline is fitted.

3.9.4.1
Menu bar:

Component Number Analysis
Analysis > HMFA > Component Number Analysis

Component Number Analysis consists in the estimation of the number of unknown mixture
constituents. A hard model with at least 2 peaks in the first component is required for this
analysis. Results are displayed in a Report Window.
You have to enter the maximum number of components to get tested.
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Available Reports
Average RMS Residuals of Component Fits
The average of RMS residuals of component fits is the best indicator for determining the component number because it is an a-posteriori figure of merit. A-posteriori means that a concrete model is actually created for each number of components and then tested for how good
it explains the data by averaging the RMS residuals over all samples. The most likely number
is reached when the next component does not significantly reduce the average RMS residuals
any more. Note that the diagram also displays a vertical line which is an estimate of the lower
bound.
Eigenvalues of Principal Components
The eigenvalues of principal components indicate how much each principal component contributes to explaining the variance of the data matrix. The most likely number of components
is reached when the next eigenvalue is small, i.e. when the next principal component does
not significantly increase the explained variance any more. Note that the diagram only displays major principal components which explain up to 99.9% of the variance.
Ratios
The ratios plot supplements the Average-RMS-residuals-plot and the Eigenvalues-plot by
showing the ratios of two successive RMS-values and eigenvalues, respectively. The most
likely number of components is indicated by a large ratio.
Factor Indicator Function
The factor indicator function reaches a minimum where the correct number of factors/components is expected. However, this only occurs when the error is random and fairly uniform
throughout the entire data. [E. R. Malinowski, Analytical Chemistry, Vol. 49 (4), April 1977].
In real cases, the function is typically L-shaped for about the first 10 components and the most
likely number of components is indicated by a more or less sharp bend in the curve.

3.9.4.2
Menu bar:

Component Analysis
Analysis > HMFA > Component Analysis

Component Analysis consists in the identification of unknown component spectra (if any) and
the computation of concentrations for each component. Results are displayed in a Report
Window. Additional input is required for this analysis:
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1

2

Firstly, if the hard model's first component contains peaks, you have to enter the number of
unknown components to be identified (1). Alternatively, you could tag some of the model's
peaks as "Distinctive (for HMFA)" via the peak’s context menu (see below) and enter "0". In
that case a separate component will be identified for each distinctive peak, using the distinctive peak as a reference peak.

Secondly, you could choose between three kinds of closure constraints (2) for post-processing calculated component weights:
•
•
•

none: computed component weights are not processed any further
Normalization: for each sample separately, computed component weights are normalized such that the sum of weights will be one.
Optimization: for all samples simultaneously, computed component weights are multiplied by common factors which are found by numerical optimization. Again, the sum
of weights will be one for each sample.

Available Reports
Component Spectra
Spectra of all identified pure components (if any) and all initially provided pure components
(if any)
Concentrations
Calculated component weights processed according to chosen closure constraint. If no closure constraint is applied, these values are in fact component weights. Otherwise, values represent dimensionless concentrations.
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RMS Spectral Residuals
Euclidean mean of differences between fitted model and measured samples
Table: Concentration Profiles
Numeric values of computed concentrations
Table: Component Spectra
Numeric values of pure component spectra

Report Customization
X-axis
By default, concentrations and RMSE values are plotted against the sample index. You can
change the x-axis to any available data set feature. See Section Data Table Editor for how to
add features to data sets.
Component Selection
By default, plots of all pure component spectra and concentrations are shown in the graphical
report. Use the list for selective plotting. Note that RMSE values are independent of the selected component.

Create Hard Model
If at least one unknown component gets identified, you can export the components as a new
hard model. When clicking Create Hard Model the bottom of the Report Window, a new
master model will be added to the Model Tree Panel. It will contain a hard model with all
identified components as separate component models.

3.9.5

Integration

Menu bar:

Analysis > Integration

Integration is applied to selected data sets. A model with integration ranges is required for
this analysis.
Integration analysis consists in the calculation of peak areas within each integration range for
each sample. Results are displayed in a Report Window.
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Integration Report Window

Available Reports
Peak Area
Calculated peak areas
Report Table
Table with numeric peak areas

Report Customization
X-axis
By default, peak areas are plotted against the sample index. You can change the x-axis to any
available data set feature. See Section Data Table Editor for how to add features to data sets.
Integration Range Selection
By default, plots of all integration ranges are shown in the graphical report. Use the list for
selective plotting.

3.9.6

Component Fitting

Menu bar:

Analysis > Component Fitting
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Component fitting is applied to selected data sets. A hard model is required for this analysis.
Component fitting analysis consists in the calculation of component weights of the hard
model for each sample. Results are displayed in a Report Window.
Component fitting is done by a mathematical procedure called model fitting, in which the
model’s parameters are automatically adjusted until the model fits a certain measured spectrum. The number of model parameters being adjusted (besides component weights) is controlled by model settings, giving the model more or less flexibility to account for peak variations in the measured spectrum like shifts or shape changes.

Available Reports
Component Weight
Calculated component weights
Component Area
Calculated component areas. Whether this report is available depends on preferences.
RMS Spectral Residuals
Euclidean mean of differences between fitted model and measured samples
Table: Component Report
Table with numeric component weights, component areas, and RMSE values. Whether this
report actually contains component areas depends on preferences.
Table: Parameter Report
Table with numeric values of all parameters of all component fits

Report Customization
X-axis
By default, component weights and RMSE values are plotted against the sample index. You
can change the x-axis to any available data set feature. See Section Data Table Editor for how
to add features to data sets.
Component Selection
By default, plots of all component weights are shown in the graphical report. Use the list for
selective plotting. Note that RMSE values are independent of the selected component.

Component Fit Preview
Toolbar:
Menu bar:
or
Toolbar:
Menu bar:

(preview linear component fit)
Analysis > Manage Fits > Preview Linear Fit
(preview component fit according to model settings)
Analysis > Manage Fits > Preview Component Fit
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The Component Fit Preview Mode can be used to visually inspect the goodness of component
fits in the desktop. A hard model is required and a data set must be active in order to enable
the preview mode.
You can either display a linear component fit or the actual component fit as specified in the
model setting. The former one is just provided for a quick preview; the latter is the important
one and is typically referred to when speaking of "component fits".
When the component fit preview mode is enabled, the Properties Panel displays properties
of the component fit instead of the original hard model and the Plot Panel shows the component fit, i.e. the fit of the hard model to the active sample.
Note: Some model parameters cannot be modified while in preview mode.

Managing Component Fits
Since component fitting could be a time-consuming operation, calculated fits will be stored
in memory. All data sets having component fits available are labeled with [C] in the Data Sets
Panel. When the preview mode is enabled, a new component fit will be computed automatically for the active sample if none exists.
Component fits will be removed from memory, when
•

modifying the hard model. You will be notified in advance:

•
•

removing fits manually via menu Analysis > Manage Fits > Remove …
shutting down PEAXACT. You could save the session in order to preserve all component fits for the next time.

Component fits can be stored permanently, when
•
•

saving the session
exporting the current component fit as new hard model to a model file via menu Analysis > Manage Fits > Export Visible Fit as New Model…
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Prediction

Menu bar:

Analysis > Prediction

Prediction is performed for selected data sets. A calibrated model is required for this analysis.
Prediction analysis consists in the calculation of features for each sample. Results are displayed in a Report Window. Different results may be available depending on the calibration
method.

Available Reports
Predicted Feature
Calculated features
RMS Spectral Residuals
The Root Mean Squared Spectral Residuals measure how well the model explains the spectral
data. RMSE values are only shown for data sets for which reference values are provided. See
also calibration reports.
Mahalanobis distance
The Mahalanobis Distance tells how well a sample matches the training samples used for calibration. The Mahalanobis Distance can be used to spot spectral outliers. See also calibration
reports.
Report Table
Table with numeric values of predicted features

Report Customization
X-axis
By default, predicted features are plotted against the sample index. You can change the xaxis to any provided data set feature. See Section Data Table Editor for how to add features
to data sets.
Feature Selection
By default, plots of all predicted features are shown in the graphical report. Use the list for
selective plotting.

Command Line Alternative
Prediction analysis can also be started from the command line with option -predict which
has advantages over the graphical user interface:
•
•
•
•

Simultaneous analysis with multiple models
Results of all models are combined in a single report file
Results will not be lost in case of a system crash
Less memory-intensive
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Suited for analyzing many samples

Prediction analysis from the command line is performed for all loaded data sets using all
opened calibrated models. In order to load models and data sets from the command line, you
could:
•
•

save a session file in advance (by using the user interface) which contains all your necessary models and data sets; then use command line options -restore or -session
<file> in addition to –predict
load additional files directly from the command line by adding filenames to the command, e.g. peaxact –predict "my model.pxm" c:\data\dataTable.xls

Results are written to a spreadsheet
<directory of first opened model>\Reports\<yyyy-mm-dd>-prediction_<#>.csv

which is located in subdirectory Reports of the first opened model file.
Note: Results are written to file directly after the analysis of a data set, i.e. results
won't get lost in case of a system crash.
See also: Command Line Options

3.9.8

Validation

Menu bar:

Analysis > Validation

Validation is performed for selected data sets. A calibrated model is required for this analysis.
Selected data sets should (but do not have to) provide values for calibrated features which
could be used as reference values for quantitative validation of the model's predictive capabilities.
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Validation analysis consists in the calculation of features for each sample and the comparison
with given feature values. Results are displayed in a Report Window. Different results may be
available depending on the calibration method.
The Validation Report Window differs from the Prediction Report Window in two ways:
1) Predicted values are shown independently for each feature and for each location (in case
of a location-dependent calibration/prediction), i.e. each calibration model can be validated separately.
2) In addition to predicted values, reports contain additional data points of samples used
during calibration. This is useful for comparing results with the original calibration.

Available Reports
Predicted vs. True
Predicted feature values are plotted against the actual values for each data set for which such
references are provided. In addition, reference values used during prediction are displayed.
Predicted vs. ...
Predicted feature values are plotted against a selectable feature. In addition, differences to
the actual values are shown for each data set for which such references are provided.
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RMS Spectral Residuals vs. True
RMS Spectral Residuals vs. ...
The Root Mean Squared Spectral Residuals measure how well the model explains the spectral
data. RMSE values are only shown for data sets for which reference values are provided. See
also calibration reports.
Mahalanobis distance vs. True
Mahalanobis distance vs. RMS Spectral Residuals
Mahalanobis distance vs. ...
The Mahalanobis Distance tells how well a sample matches the training samples used for calibration. The Mahalanobis Distance can be used to spot spectral outliers. See also calibration
reports.

Report Customization
X-Axis
For some reports, you can change the x-axis to any provided data set feature. See Section
Data Table Editor for how to add features to data sets.
Feature Selection
Use the pull-down menu to display results for individual calibrated features.
Location
Use the pull-down menu to display results for individual locations.

3.10 License Management
Menu bar:
Menu bar:

Help > Licensing…
Help > About PEAXACT

From the Help menu you can open the License Activation Dialog and the License Information
Window.

License Activation
The License Activation Dialog can be used to change the current license file. The new license
must be valid for the PEAXACT program.

License Information
The License Information Window provides information about the activated license, e.g.
which software modules you are allowed to use, for how long, and which version.
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3.11 Technical Support
3.11.1 Request Support
Menu bar:

Help > Support…

You can use the Support Request Window to send e-mails to Technical Support directly from
within PEAXACT.

You may want to send support requests for different purposes, e.g.:
•
•
•
•

asking for help
reporting a bug / crash
suggesting new features
giving any kind of feedback

In each case, provide a subject and description of the issue you are facing with. You can optionally attach related files, e.g. a screen shot or a session file. When clicking the Send button,
an e-mail is sent to support@s-pact.de, creating a new support case. If your computer is currently offline or uses protective methods to restrict internet access, you can click on Open in
E-Mail Client instead to have the mail sent by your default e-mail application.

3.11.2 Share Desktop with Technical Support
Menu bar:

Help > Share PEAXACT Desktop…
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You can share your PEAXACT desktop with an S•PACT support engineer in order to get a
possible solution for an issue you are facing.

Share offline
If you choose this option and click Continue, data of your working session are saved as a ZIP
file which you can send to Technical Support. Optionally tick the Request support now…
checkbox to open the Support Request Dialog and create a new support case.
Note: Technical Support can provide you with a secure upload link for large files.

Share online (Remote Support)
If you choose this option and click Continue, the Support Request Dialog opens which can be
used to invite a support engineer to connect to your desktop via the internet. At the scheduled time you need to start the remote support client.
The remote support client can be downloaded from www.s-pact.com/support/remote. Alternatively, you can tick the Start remote support client now… checkbox to download and start
the client automatically when clicking Continue.
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Remote Support Client
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4 ANALYSIS WORKFLOW
4.1

Visual Data Inspection
Visual Data
Inspection

Load Data Set(s)

Activate Model

Data Inspector

Edit Data Sets

Visualize Samples
Data Inspection Workflow
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Peak Picking
Peak Picking

Load Data Set(s)

Modeling
(optional)

New Model

Edit
Pretreatment
Model

Analysis

Activate Model
(optional)

Peak Picking
Analysis

Peak Picking Workflow
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Multivariate Curve Resolution (MCR)
MCR-ALS

Load Data Sets

Visual Data
Inspection

Modeling
(optional)

Analysis

New Model

Edit
Pretreatment
Model

Activate Model
(optional)

MCR Component
Number Analysis

MCR Component
Analysis
MCR-ALS Workflow
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Hard Modeling Factor Analysis
(HMFA)
HMFA

Load Data Sets

Visual Data
Inspection

Modeling

Analysis

New Model

Activate Model

Choose
Representative
Data Set
Build
Representative
Hard Model

HMFA
Component
Number Analysis
HMFA
Component
Analysis

Component
Fitting Analysis
HMFA Workflow
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Integration Analysis
Integration

Load Data Set(s)

Visual Data
Inspection

Modeling

Analysis

New Model

Activate Model

Edit
Pretreatment
Model

Integration
Analysis

Build Integration
Model
Integration Analysis Workflow
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4.6 Component Fitting Analysis
Component
Fitting

Load Data Set(s)

Visual Data
Inspection

Modeling

Analysis

New Model

Activate Model

Edit
Pretreatment
Model

Component
Fitting Analysis

Build Hard
Model

Adjust Fitting
Options

Component Fitting Analysis Workflow
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Partial Least Squares (PLS) Prediction
PLS Prediction

Load Data Sets

Visual Data
Inspection

Modeling

Analysis

New Model

Activate Model

Edit
Pretreatment
Model

Prediction
Analysis

PLS Calibration
PLS Prediction Workflow
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4.8 Peak Integration (PI) Prediction
PI Prediction

Load Data Set(s)

Visual Data
Inspection

Modeling

Analysis

New Model

Activate Model

Edit
Pretreatment
Model

Prediction
Analysis

Build Integration
Model

PI Calibration
Peak Integration Prediction Workflow
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4.9 Hard Model (HM) Prediction
HM Prediction

Load Data Set(s)

Visual Data
Inspection

Modeling

Analysis

New Model

Activate Model

Edit
Pretreatment
Model

Prediction
Analysis

Build Hard
Model

Component
Fitting Analysis

Adjust Fitting
Options

HM Calibration
HM Prediction Workflow
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4.10 Validation
Validation

Load Data Set(s)

Visual Data
Inspection
Activate
Calibrated
Model
Validation
Analysis
Validation Workflow

Solutions for Process Analytics & Control Technology

5 - TROUBLE SHOOTING

123

5 TROUBLE SHOOTING
Graphics problems
Symptoms
Some PEAXACT windows such as the Desktop or the Data Inspector are not displayed correctly. Those graphics problems e.g. may include upside-down text, duplicated text, and misplaced axes tick labels.
Cause
Problems are related to hardware-based graphics acceleration performed by some video
cards.
Resolution
Start PEAXACT with command line option -openglfix. This forces the usage of softwarebased graphics acceleration. You should only use this command line option if you encounter
graphical problems because software-based acceleration is typically slower than hardwarebased acceleration.
•
•

Right-click the Windows Desktop and choose New > Shortcut
Enter
"<INSTALLPATH>\peaxact.exe" -openglfix

•
•

including quotes; replace <INSTALLPATH> with the PEAXACT installation path on your
computer.
Click Next and enter a shortcut name.
From now on start PEAXACT using the new shortcut.

PEAXACT immediately shuts down during startup
Symptoms
Nothing happens when starting PEAXACT from the Windows desktop or start menu. The
PEAXACT process more or less shuts down immediately, potentially not even showing the
splash screen.
Cause
This error can have several reasons, e.g. it may result from incomplete installation, missing
user privileges, corrupted cache files, and others.
Resolution
Start PEAXACT from the command prompt in order to get displayed an error message.
•
•

•

From the Windows start menu, run cmd which opens a command window
At the command prompt, type
"c:\Program Files\S-PACT\PEAXACT 4\peaxact.exe" -logLevel debug
You may need to replace the directory with the PEAXACT installation directory on
your computer. Don't forget the quotes.
PEAXACT probably fails to start again, but an error message will be displayed.
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Error Message

See further

Error message involves file mclmcrrt90.dll

Missing mclmcrrt90.dll

Initialize component instance failed
Inaccessible cache
Could not access the MCR component cache.
Undefined function or variable 'matlabrc'

Corrupted cache

This application has requested the run time Other Problems
to terminate in an unusual way.
Others

Other Problems

PEAXACT starts with error regarding missing mclmcrrt90.dll
Symptoms
When starting PEAXACT, a dialog box appears showing a message similar to:
This application has failed to start because mclmcrrt900.dll was not found.
Cause and Resolution
mclmcrrt90.dll is a run-time library needed to run PEAXACT. This library is installed during
the course of the MATLAB Compiler Runtime (MCR) installation.
This error typically results from one of two situations:
1) The correct version of MATLAB Compiler Runtime (MCR) is not installed.
PEAXACT depends on a specific version of the run-time library. Please follow the installation instructions in this documentation.
2) A second option is that the system's PATH environment variable was not set correctly.
During the course of the MATLAB Compiler Runtime installation, one of the following directories should have been added to your system path:
C:\Program Files\MATLAB\Matlab Runtime\v90\runtime\win32
C:\Program Files (x86)\MATLAB\Matlab Runtime\v90\runtime\win32
C:\Program Files\MATLAB\Matlab Runtime\v90\runtime\win64

To work around this issue, manually update the PATH environment variable on your deployment machine. Alternatively, re-installation of MATLAB Runtime should fix this
problem.
Also note that since these DLLs have different names for each version of the MCR, multiple versions of the MCR can be installed on the same machine. Make sure to have the right
version installed for PEAXACT.
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Inaccessible MCR component cache
Symptoms
The following error is displayed during PEAXACT startup:
Initialize component instance failed.
Could not access the MCR component cache.
Cause
During startup, PEAXACT extracts files to the MCR component cache directory. The error occurs when these files cannot be written or read. By default, the MCR cache is located in the
user's application data directory to which the user normally has full writing permissions. However, depending on the configuration of your Windows user profile, this might not be the
case.
Resolution
There are two possible solutions:
1) Changing your Windows user's privileges. Contact your system administrator and request
writing permissions for the following directory: %LocalAppData%\Temp
Because it might conflict with the security policy of your company, this solution is not
recommended.
2) Redirecting the MCR cache directory:
•
•

From the Windows start menu, run notepad or any other text editor
In the text editor, type
set MCR_CACHE_ROOT=c:\MCR
if not exist "%MCR_CACHE_ROOT%\nul" mkdir "%MCR_CACHE_ROOT%"
"c:\Program Files\S-PACT\PEAXACT 4\peaxact.exe"

•
•
•

You may need to substitute c:\MCR with a directory and path for which you have writing permissions. Also, replace c:\Program Files\S-PACT\PEAXACT 4 with the PEAXACT
installation directory on your computer.
Save the text file as peaxact.bat on your Windows desktop. Note that the file extension must be "bat" and not "txt" (which would be the default).
Double-click the peaxact.bat file on your Window desktop

Corrupted MCR component cache
Symptoms
The following error is displayed during PEAXACT startup:
Undefined function or variable 'matlabrc'.
Cause
During startup, PEAXACT extracts files to the MCR component cache directory. The error occurs when these files get corrupted.
Resolution
Delete the content of the MCR cache directory:
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Browse to the cache directory by typing the following into the address bar of the Windows Explorer:
%LocalAppData%\Temp\%UserName%\mcrCache9.0

•

Delete all files and folders within the cache directory.

Other Problems
If you encounter a problem not mentioned here, try the following:
•

•
•

Start PEAXACT with startup option –logLevel debug. There is a file shortcut in the
PEAXACT installation directory called PEAXACT 4 Debugging which starts PEAXACT
with this option.
Check the PEAXACT log file for possible explanations
Take a screenshot from the command window

If you cannot solve the problem on your own, send the log-file and the screenshot to Technical Support: support@s-pact.de
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